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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Financials for Mexico

General Ledger Reporting

Enable the Mexican Reporting Processes

To run the Journals for Mexico and Chart of Accounts for Mexico reports, you must enable the processes once to run
them from the Scheduled Processes page in Oracle Fusion Cloud Applications .

Enable the Process
To enable the processes, follow these steps:

Signin as a IT_SECURITY_MANAGER user.

Select Tools > Security Console.

Click Create Role on the Roles page.

Enter the new role name with Role Code as Mexico_Reports_Custom.
Click Next to add the required privileges.

Add the required roles:

oA WNRA

Click Add Function Security Policy.

Search for a required role.

From the search result, select and add the privilege roles and not the OBI roles.
d. Click Add Privileges to Role.

Similarly, add all the required privileges.

Verify that all the privileges were added successfully.

Click Next twice to go to the role hierarchy definition page.

Add the roles containing your Mexican Jobs:

o JL_GENERATE_CHART_OF_ACCOUNTS_FOR_MEXICO_ELECTRONIC_ACCOUNTING_PRIV_OBI
o JL_GENERATE_JOURNAL_ENTRIES_FOR_MEXICO_ELECTRONIC_ACCOUNTING_PRIV_OBI

11. Verify that all the roles have been added

12. Click Next to add the job role to the required users, such as the Mexican Manager.

13. Once all users are added, click Next and then click Save and Close to complete the job role definition.

14. Signin as an Application_Implementation_Consultant user and navigate to the Setup and Maintenance page.
15. Inthe Setup and Maintenance work area, select these options:

noo
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o Offering: Financials
o Functional area: Enterprise Profile
o Task: Manage Reference Data Set Data Access for Users

16. Select the Users with Data Access option and identify the user you need to add data access to.
17. Click Search to see all the existing data access privileges for this user.

18. Click the Create icon to add the new job role data access.

19. Add the required security contexts.
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Note: The usual set defined to cover all possible requirements is: Ledger, Data Access Set, Reference Data
Set, and Business Unit.

It is advisable to run a final process whenever there is a change in job roles. This is accessed from the Setup and
Maintenance page. Just select and click Submit. Follow its progress from the Tools > Scheduled Processes page.

Assign a Job Role to Users
After the job role is created and you can add it to a user.

Follow these steps:

Open the User Accounts page.

Select the job role and click Edit.

Keep clicking Next till you see the Add User page.
Add the user to the role.

Note: Alternatively, you can select the user on the User Accounts page, click Edit, and add the role.

PUNA

5. Click Save and Close to complete the setup.

You will also need to add the required data access for this user.

How You Capture Electronic Invoice Information for Mexico

The Journals for Mexico report collects information on all transactions that are accounted and posted in different
subledgers. The report also captures information related to electronic invoices generated for sales, received from
suppliers for purchases, or from manually entered journals.

However you must update the global descriptive flexfields when entering and posting transactions in Oracle Payables,
Oracle Receivables, and Oracle General Ledger.

Global descriptive flexfields store the unique identifier and invoice number issued either by the Tax Administration
Services (SAT) or by an authorized service provider (PAC).

This table summarizes the flexfields you must update for electronic invoices when you create an invoice or transaction
in Payables, Receivables, Expense Reports or manual General Ledger entries.

Global Descriptive Flexfields Used in Description

Digital Tax Receipt using Internet Unique ID - AP Invoices Enter the unique identifier of the Comprobante
Fiscal Digital por Internet. CFDI is an electronic
billing schema that simplifies the process of
AR Invoices issuing and receiving invoices and involves
engaging an authorized certification provider.

AP Payments

AR Receipts
Manual GL Entries

Digital Tax Receipt Serial Number - AP Invoices Enter the serial number on the Digital
. Fiscal Document or Fiscal Document with
AR Invoices Bidirectional Bar Code (CFD/CBB). CFD/CBB is

a paper-based fiscal document that contains an

ORACLE
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Global Descriptive Flexfields

Digital Tax Receipt Invoice Number

Foreign Invoice Number

Payment Method

Receipt Number

Tax Payer ID

Used in

- AP Invoices

- AR Invoices

- AP Invoices

- AP Payments

- Expense Reports

- Manual GL Entries

To capture all the Mexican transactions correctly:

- In Payables, you can:

Chapter 1
Financials for Mexico

Description

authorized bidirectional bar code. This type of
fiscal document is issued to taxpayers whose
annual income is less than four million Mexican
Pesos.

Enter the invoice number on the CFD/CBB.

Enter the foreign invoice number, if it exists.

Select the payment type from the given list of
values

Enter the unique identifier of CFDI. CFDl is an
electronic billing schema that simplifies the
process of issuing and receiving invoices and
involves engaging an authorized certification
provider.

Enter the tax payer ID of the transaction
corresponding the manually entered journal in
GL.

o Select Invoices for Mexico from the Regional Information list on the Additional Information tab on the
Show More page of the invoice header. Ignore the Routing Attributes 1-5 for now.

o Select invoice lines for Mexico from the Regional Information list on the Update Additional Information
dialog box, which appears after clicking the Details icon on the Payables invoice line.

- For Payables Payments, select Payments for Mexico from the Regional Information list on the Additional
Information tab of the payment header.

- In Receivables, select Transactions for Mexico from the Regional Information list on the Miscellaneous tab of

the transaction header.

- In Receivables Receipts, select Receipt for Mexico from the Regional Information list on the Additional
Information section of the AR Receipt header.

Note: You must already define a payment method for the receipt method used in the Receivables Receipts.
You can define this method using Receipt Classes for Mexico from the Regional Information list on the
Receipt Classes and Methods page.

For Expense Reports, define the Receipt Number field to identify the UUID code on the Detail page of the
expense item definition. The page can be accessed directly by clicking the Create New Expense Item button or
from the detail section of an expense report by adding (and defining) a new expense item. Apart from the UUID
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entered at the Receipt Number field, Merchant Name and Taxpayer ID fields are also mandatory for extracting
the information.

Note: If you provide a valid UUID in the Receipt Number field, the transaction is considered as an expense
report with a UUID. Otherwise, it's treated as a foreign invoice reported under NumFactExt. The Valid UUID
format is: ad662d33-6934-459c-a188-bdf03930f444.

- For manual General Ledger transactions, select Journals for Mexico from the Regional Information list on the
Journal tab of the Show More page of the journals header.

If an invoice is paid in multiple installments, capture each payment separately. Update the GDFs with the details of your
payments.You can access the GDFs from the:

- Payment Installments dialog box in Payables

- Review Installments dialog box in Receivables

Chart of Accounts for Mexico Report

This topic includes details about the Chart of Accounts for Mexico report.

Overview

Companies in Mexico must submit accounting information to the tax authorities. According to the new government
regulations, companies must upload accounting information to the Tax Administration Services (SAT) internet portal
through a registered email account.

Note: You can use your taxpayer identification registry (RFC) to register your email on the SAT portal.

Fiscal authorities in Mexico publish the official chart of accounts that all companies must use to report accounting
information. This referential chart of accounts assigns a code to each account, and a level to identify parent/child
relationships for reporting purposes. You must set up these codes in Oracle Fusion Cloud Applications .

This image shows an example of the report:
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Key Insights

You must map accounts from your company's chart of accounts to the SAT grouping codes in the Chart of Accounts
Mapping page. Only the accounts that are mapped to the SAT grouping codes are included in the report.

You can define the company's natural account segment as a single level or a hierarchy. If you implement an account
hierarchy, a child account can have a single parent account (recommended) or multiple parent accounts. When a child
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account has multiple parent accounts, only the immediate parent appears on the report. You can map more than one
account to a given SAT grouping code.

Before you run the report, ensure the natural accounts appear at the correct level in the account hierarchy. Perform the
following steps to update the level of natural account according to the account hierarchy:

1. Inthe Setup and Maintenance work area, select these options:

o Offering: Financials

o Functional area: Financial Reporting Structure

o Show: All Tasks

o Task: Manage Account Hierarchies
Select the account.
From the Actions menu, select Flatten and click Row Flattening.
Click Force Flatten.

From the Actions menu, select Flatten and click Column Flattening.
Click Force Flatten.

oA WN

Note: To run the Chart of Accounts for Mexico process from the Scheduled Processes page, you must give access to
the user you use to manage the electronic accounting reports for Mexico. For more information, see the Enable the
Mexican Reporting Processes topic.

Report Parameters
This table describes the selected process parameters.

Parameter Description

Seal Enter the digital electronic seal information provided by the fiscal partner.

Certificate Number Enter the certificate number information provided by the fiscal partner.

Certificate Enter certificate information provided by the fiscal partner.

Format Version Enter the format version of the file defined by the Government of Mexico. It can change over time, such

as 11,1.2, and 1.3. Currently it defaults to 1.3.
Chart of Accounts Mapping Enter the chart of accounts mapping created for Mexico.

Legal Entity Enter the legal entity, which determines the RFC humber to be stamped on the report.

Frequently Asked Questions

This table lists frequently asked questions about the Chart of Accounts for Mexico report.

ORACLE
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FAQ Answer
How do | find this report? Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
Who uses this report? Financial accountant
When do | use this report? Use this report to provide detailed chart of accounts information to the tax authorities in Mexico.
What type of report is this? Oracle Analytics Publisher

How You Configure Chart of Accounts for Mexico Report

The Chart of Accounts for Mexico report displays all the mapped accounts of your company and the corresponding SAT
accounts in XML format.

Before you run the Chart of Accounts for Mexico report process, you must complete these setup steps:
- Set up the company's Taxpayer Identification Registry (RFC)
Define a value set and values for the company segment
Define a value set and values for the account segment
Define the contra account for Mexico
Define a value set and values for the contra account segment
Define the chart of accounts

Define the chart of accounts mapping

Set Up Taxpayer Identification Registry for the Company
Update the legal entity to specify the taxpayer identification registry (RFC).

Sign in as an Application_Implementation_Consultant user and navigate to the Setup and Maintenance page.

In the Setup and Maintenance work area, select these options:

- Offering: Financials
Functional area: Legal Structures

- Task: Manage Legal Entity Registrations

To register a legal entity, you need to select it from the Selected Scope List. If the required legal entity isn't in the list,
select the option Select and Add. The list of all the legal entities defined in the application is displayed. Select the one
defined for Mexico and click Apply and Go to Task.

After the selected scope is set, the page for the Legal Entity Registration opens for the selected legal entity. To define
the RFC, click the Edit button.

I Note: If RFC value isn't specified in the Legal Entity Registration, RFC will be blank in Journals for Mexico report.
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Define Value Set and Values for Company Segment
1. Signin as an Application_Implementation_Consultant user and navigate to the Setup and Maintenance page.
2. Inthe Setup and Maintenance work area, select these options:
o Offering: Financials
o Functional area: Financial Reporting Structures
o Task: Manage Chart of Accounts Value Set

Click the Create icon or Action > Create to create a new value set.
Search the value set you just created and then click Manage Values.
On the Manage Values page, click Create to add a value.

vk W

Define Value Set and Values for Account Segment

Just as you created the value set for company segment, use the Manage Chart of Accounts Value Set page to create a
value set for the account segment. Use the Manage Values page to create the values for the account segment value set.

It is preferable to enter the GL Accounts after the Chart of Accounts structure is defined and the value set is assigned to
the Natural Account segment. This helps you to define all the qualifiers for each account.

Note: To correctly map the source accounts of your company to the SAT target accounts, don't define the SAT level 1
accounts (such as 1, 2, 3 and so on) as parents of SAT level 2 accounts (such as 11, 1.2, 21, and so on). The SAT account
segment doesn't require a hierarchy definition.

Define Contra Account for Mexico

The contra account segment label indicates the contra accounts that are reported in the Chart of Accounts for Mexico
report. A contra account is an account used in an account ledger to reduce the value of a related account. The natural
balance of a contra account is opposite of the associated account.

Define contra accounts (rectifier accounts) for offset account types such as assets, liabilities, and owner equity. You
must correctly identify and mark your contra accounts.

In the Chart of Accounts for Mexico report, the contra accounts are displayed in the Natur field of the Ctas element with
reversed values. Let this table give you an idea. Here, D stands for debit and A stands for credit.

Account Type Code Description Debit or Credit Field Value
A Assets DR D
A Rectifier Assets CR A
L Liability CR A
L Rectifier Liability DR D
) Owner Equity CR A
) Rectifier Owner Equity DR D
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Account Type Code Description Debit or Credit Field Value
E Expense DR D
R Revenue CR A

Use the Manage Segment Labels page to create a new contra segment for Mexico.

1. Signin as an Application_lmplementation_Consultant User and navigate to the Setup and Maintenance page.
In the Setup and Maintenance work area, select these options:

o Offering: Financials

o Functional area: Financial Reporting Structures

o Task: Manage Chart of Accounts Structures
Search for the key flexfield name.

Select the flexfield and then select Action > Manage Segment Labels.
. Add a new row for MX_CONTRA_ACCOUNT.

N
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Define Value Set and Values for Contra Account Segment

Use the Manage Chart of Accounts Value Set page to create a value set for the contra account segment. Use the
Manage Values page to create the values for the contra account segment value set. Y as the contra account segment
value indicates that the contra accounts will report the Natur field (of element Ctas) with reversed values.

Define Chart of Accounts
Define the SAT chart of accounts for Mexico and include these segments:

- Company account segment
- Account segment
- Contra account segment

—

Sign in as an Application_Implementation_Consultant User and navigate to the Setup and Maintenance page.
2. Inthe Setup and Maintenance work area, select these options:

o Offering: Financials

o Functional area: Financial Reporting Structures

o Task: Manage Chart of Accounts Structures

3. Search for the key flexfield name.

4. Select the flexfield and then click Manage Structures.

5. On the Manage Key Flexfield Structures page, click the Create icon or Action > Create to create a new chart of
accounts structure.

6. Save the chart of accounts structure.

7. Create account segments for company, account, and contra account with the relative qualifiers.

After adding all the required segments, define the Accounting Flexfield structure instance.

1. Onthe Manage Chart of Accounts Structures page, click Manage Structure Instances.
2. Select the required chart of accounts structure and click the Edit icon.
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3. Open each segment in edit mode and select the Required and Bl enabled check boxes.

After setting the flexfield structure instance and adding all the natural accounts, you must deploy the accounting
flexfield.

1. Select the accounting flexfield on the Manage Chart of Accounts Structures page.
2. C(Click Deploy Flexfield.

Define Chart of Accounts Mapping

Define the chart of accounts mapping with source as the primary chart of accounts of your company and target as the
SAT chart of accounts.

Follow these steps:

1. Signin as an Application_Implementation_Consultant User and navigate to the Setup and Maintenance page.
2. Inthe Setup and Maintenance work area, select these options:

o Offering: Financials
o Functional area: Financial Reporting Structures
o Show: All Tasks
o Task: Manage Chart of Accounts Mappings
3. Click the Create icon to create a new mapping.

It is recommended that you map the natural account segment values between the chart of accounts of your company
and the SAT chart of account. You can do this in multiple ways:

- Assign single value as the mapping method for the company target segment.
Use rollup rules as the mapping method and Account as the source segment for the account target segment.

Use rollup rules as the mapping method and Account as the source segment for the contra account target
segment.

If the source accounts are contra in nature, create a rollup rule. Map the target value to the source account values (the
primary chart of accounts).

To complete the mapping, follow these steps:

1. Click the Segment Rules tab.

o Inthe Rollup Rules, enter Y as the target value and assign the from and to values for the accounts.
2. Click the Account Rules tab.

a. Enter the target SAT account.
b. Specify the source account using the filter conditions.

Journals for Mexico Report

This topic includes details about the Journals for Mexico report.
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Overview

Companies in Mexico must submit accounting information to the tax authorities. Companies must upload accounting
information to the Tax Administration Services (SAT) internet portal through a registered e-mail account.

Note: You can use your taxpayer identification registry (RFC) to register your e-mail address on the SAT portal.

The Journals for Mexico report collects information on all transactions that are accounted and posted in different
subledgers. The report also captures information related to electronic invoices generated for sales or received from
suppliers for purchases, as well as manually entered journals. However, you must update the global descriptive flexfields
when entering and posting transactions in Oracle Payables, Oracle Receivables, and Oracle General Ledger.

This image shows an example of the report.
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Key Insights

To run the report, you must first enable the Journals for Mexico process so that you can run it from the Scheduled
Processes page. For more information, see Enable the Mexican Reporting Processes.

When you run the Journals for Mexico process, detailed transaction information is extracted from General Ledger for
the specified period.

The report is generated in an XML format and includes these sections:

- Heading: Includes layout version, RFC number, and the date on which the report is generated.

10
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- Details: Provide accounting information from the journal entries. Note that the UUID information depicted in
the GL journals is extracted directly from the AR and AP transactions. Any change in these transactions at the
subledger level don't need additional transfer actions to be included in the journals report.

Do note:

o Records in the journal entries are grouped based on your Payables and Receivables settings. The
information in the expense reports are tracked from the Payables transactions. GL entries are depicted as

they're entered in GL.

o Your role requires the data security privilege, Report Person National Identifier. The report shows the
employee national identification number for payment requests from Expenses.

Report Parameters

This table describes selected process parameters.

Parameter

Request Type

Audit Request Number

Audit Process Number

Journal Version

Seal Number

Certificate Number

Digital Seal Certificate

Journal Source

Show Adjustment Periods

Ledger

From Period and To Period

ORACLE

Description

Select the audit request type indicated by the Government.

- AF - Audit Event
« FC- On-site Audit
« DE - Return

- CO - Compensation

Specify the audit request number, when the request type is audit event (AF) or on-site audit (FC).

Specify the audit process number, when the request type is return (DE) or compensation (CO).

Enter the format version of the file defined by the Government of Mexico. It can change over time, such
as 11, 1.2, and 1.3. Currently, the default value is 1.3.

Specify the digital electronic seal provided by the Government for the accounting file.

Specify the digital certificate seal that protects the electronic accounting file.

Specify digital seal certificate that protects the electronic accounting file.

Specify the name of the journal source. When you specify the source, the journal lines from that source
are extracted. When you specify ALL, journal lines from all the subledgers are extracted.

Specify whether data during the adjustment period must be extracted and reported.

Specify the ledger from which you want to extract data. When you specify a ledger, only posted journal
lines in that ledger are extracted.

Specify the range of subledger periods to be included for extracting data.

1
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Parameter Description
From Date and To Date Specify the date range to be included for extracting data. Date range must be between the From Period

and the To Period parameters.

Posting Status Specify whether posted data must be included in the report.

Include Zero Amount Lines Specify whether zero amount lines must be included in the report.

Frequently Asked Questions

This table lists frequently asked questions about the Journals for Mexico report.

FAQ Answer

How do | find this report? Schedule and run this report from the Scheduled Processes work area on the Navigator menu.
Who uses this report? Financial accountant

When do | use this report? Use this report to provide detailed accounting information to the tax authorities in Mexico.
What type of report is this? Oracle Analytics Publisher

Trial Balance Report for Mexico

This topic contains summary information about the Trial Balance Report for Mexico.

Overview

The trial balance report is an XML file that includes a summary of the initial balances, the sum of total transactions for
the period, and the final balances for each account that you report in the Chart of Accounts XML file. The accounts
related to assets, liabilities, equity, and results of operations (revenues, costs and expenses) are all included.

Key Insights

After generating the report from your folder in the General Accounting: Financial Reporting Center, convert the report to
an XML format so that it's ready to upload to the Tax Administration Services (SAT) website.

You can create the report once and use it periodically. The report can also be modified based on the requirements from
the Federal Government.

12
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Frequently Asked Questions

The following table lists frequently asked questions about the Trial Balance Report for Mexico.

FAQs Answer
How do | find this report? Run this report from your folder in the General Accounting: Financial Reporting Center.
Who uses this report? - Financial Accountants

Financial Specialists

When do | use this report? Use the Trial Balance Report for Mexico to know the summary of the initial balances, the sum of total
transactions for the period, and the final balances for each account that you report in the Chart of
Accounts XML file.

What type of report is this? Oracle Analytics Publisher

Related Topics
« Create a Trial Balance Report for Mexico

« Convert the Trial Balance Report for Mexico to XML Format

Create a Trial Balance Report for Mexico

The trial balance report is an XML file that includes a summary of the initial balances, the sum of total transactions for
the period, and the final balances for each account in the Chart of Accounts XML file.

The report includes information on accounts related to assets, liabilities, equity, and the results of operations (revenues,
costs and expenses).

Use the Financial Reporting Web Studio to create the Trial Balance Report for Mexico. You can create the report once
and use it periodically. The report can also be modified based on the requirements from the Federal Government.

Note: Ensure that you configured the chart of accounts . For details about how to configure the chart of accounts, see
How You Configure Chart of Accounts for Mexico Report topic.

Perform the following steps to create the report:

1. From the Financial Reporting Center work area, select the Tasks panel tab and click Open Workspace for
Financial Reports.

On the Tools menu, select Launch Financial Reporting Web Studio.

Click File > New > Report or click the New Reporticon.

Use the Report Pallet page as the container to build your report.

Click Insert > Grid... or click the New Grid icon.

A WN
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6. Click and hold the left mouse button to select a large area of the grid to create the report.

The Select a Database Connection dialog box appears when you release the mouse after setting the size and
position of the grid.

Click the Database Connection list.
8. Select your database. A unique cube exists for each combination of chart of accounts and accounting calendar.

N

Note: The user name and password are the login credentials you used to access the Financial Reporting Web
Studio.

9. Click OK.

The Dimension Layout dialog box appears. Set the point of view dimensions and accounts for the rows,
columns, and page levels.

10. Use the Dimension Layout dialog box to arrange your dimensions. Move:

o Accounting Period and Balance Amount to Columns.

o Account to Rows.

I Tip: Click the icon in front of the name to select the dimension to move to the designed area.

The following figure illustrates how the dimensions appear on the Dimension Layout dialog box after you
made your selection.

[Dimiision Layons - ) )
Gind Database Connection

Imlﬂ GL_CperationsAccourtingFle

Drag dimensions to rows, columns, pages, or the Point of View.

Poirtt of View
" Ledger " BalSeq Comp: " Department 7 Sub-fccount i Produd
i@’ Scenaro gp” Amount Type g’ Cumency i’ Cumency Type
Pages Columns
é" Accounting Period
" Balance Amount
Rows
g’ Account

u::m:] Cancel I‘juhl
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11. Click OK.

You return to the grid which has the selected dimensions.
12. Add additional rows and columns to the grid according to your requirement.
o Columns: Copy column A and paste it four times to see columns A to E.
o Rows: Select row 1, right-click and select Insert Row > Text. Insert ten rows.

13. Enter the row text in each row cell. The following table lists the row text for each row.

Row Text
1 Version="1.3"
Note:

You can update the version number anytime.

2 RFC="SYS11103"

Note:
You can update the RFC anytime.

3 Mes="<<MemberName ("Gridl", "AccountingPeriod")>>"

4 Anio="<<MemberName ("Gridl", E, "AccountingPeriod")>>"
5 TipoEnvio="N" (User needs to fill value)

6 FechaModBal=" " (User needs to fill value)

7 Sello="Seal" (User needs to fill value)

8 noCertificado ="13" (User needs to fill value)

9 Certificado="cERT" (User needs to fill value)

10 Update the row cell and columns for row 10 with the following values:

o Row cell with NumCta
o Row 10, Column A with Saldo Ini

o Row 10, Column B with Debe

15
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14.

15.
16.
17.

18.
19.
20.
21.

22.
23,

24.
25.
26.

Row Text

o Row 10, Column C with Haber

o Row 10, Column D with SaldoFin

The following figure illustrates how the grid should appear:
A B C i E
| A.-:-:-:uumngF : | AccountingP | AccountingP | AccountingP A-:cuurﬂngF'Ena :
 Balance Amo | Balance Amo ' Balance Amo Balance Amo Balance #.mol.m

1 |Version="13"
2 |mecsysmoar L L

3 cha- <(|'U'|embErNgrrE[ L_md'l Fu:l:uurﬂngF‘EﬂDd |>} )
4 | Anio="<<MemberName("Grid1", E, " -%::v::m.rmngF‘enud }“:"

5 | TipoEnvio="N"
6 |FechaModBal="" | .
7 | Sello="Seal"

8 nuCertﬁcadu = 13
9 | Certificado="cERT"

In the flrst column on the grld (Column A) double-click the AccountmgPerlod cell.

The Select Members dialog box appears.

Remove the default selection from the Selected pane and assign a user-defined period selection.

Select the AccountingPeriod in the Selected pane and click Remove.

Select Current Point of View for Accounting Period from Available pane and click Move to place it in the
Selected pane.

Select the Place selection into separate columns option.

Click OK.

Repeat the steps for Columns B, C, and D.

In the last column on the grid (Column E), double-click the AccountingPeriod cell to open the Select Members
dialog box.

Select the AccountingPeriod in the Selected pane and click Remove.

Select Current Point of View for Accounting Period from Available pane and click Move to place it in the
Selected pane.

Click the Functions tab and select RelativeMember from the list.

Click Add.

Use the Edit RelativeMember Function dialog box to add the parameter values. The following table lists the
values you can enter.

Parameter Value
Member Current Point of View for Accounting Period
Offset 0

16
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Parameter Value
Hierarchy AccountingPeriod
RelativeMemberList Fiscal Year
27. Select the Place selection into separate columns option.

28.
29.

30.
31.
32.
33.
34.
35.

Click OK.
In the first column on the grid (Column A), double-click the BalanceAmount cell.

The Select Members dialog box appears.

Remove the default selection from the Selected pane and assign a user-defined selection.
Expand the Balance Amount node in the Available pane and select Beginning Balance.
Click Move.

Select the Place selection into separate columns option.

Click OK.

Repeat the steps and assign the user-defined properties as shown in the table for the BalanceAmount cell in
the other columns.

Column Parent Node Custom Selection
B Period Activity Period Activity Dr
@ Period Activity Period Activity Cr
D Ending Balance Ending Balance

E Ending Balance Ending Balance
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36.

37.
38.
39.
40.

41.
42,
43.
44.
45.
46.
47.

48.

Column Parent Node Custom Selection

The following figure illustrates how your grid appears when you finish updating user-defined values for all the
dimensions.

A B C 1] E

! Cumrert Point H Falativs la Cumrerd Pairt

+ of Ve for Currerd Port of View | Cument Poird of View | Cumert Point of View © of Wew for

{ AocourtingP | for AccountingPerod for AccourtingPerod | for AccountingPanod | Accounting Perod ofset

(|

: Balance Period Activity Dr Actiuty C Endng Ealance ding Balance
! |Version="13" Lo P,k O Do |
2 |RRC"SYsvneE o T | R N
3| Mes="ccMemberbame [ Grid 1*, "AccountingPeriod )55~ ! !
4 Anig="<<MemberName({"Gnd 17, E. “AccountingPenod )"
5 | TipoEnwe="N" i
f |FechaModBal="" '
T |Selle="Seal” | N R S SR
8| naCertificads ==13"
| Centfficado~"cERT~ :
10| MumiCta | Saldo Ini Debe Haber | SaldaFin

Select column E.

The Custom Properties dialog box appears.

Select the Hide Always check box.

Select the first two rows (row 1and 2).

Select the Hide Always check box in the Custom Properties dialog box.
Select row 11, right-click and click Insert Row > Data. Row 12 is added.

Note: For each account in the SAT chart of accounts mapping, add a row.

Double-click the Account cell in row 11 to open the Select Members dialog box.
Select Account in the Selected pane and click Remove.

Click the Members tab.

Expand the Account > All Account Values nodes that appear in the Available pane.
Select 1110 and click Move. The account appears in the Selected pane.

Select the Place selection into separate columns option.

Click OK.

You can follow the similar steps to add all your natural accounts.
Update the dimensions that appear in the grid with the values specified in the following table.

Note: To update the dimensions, double-click the respective dimension buttons to open the Select Members
dialog box. Select the values as specified in the table in the Select Members dialog box and click OK.

Dimension Value

AccountingPeriod Qtr1-00 for the year 2000
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Dimension

Scenario

Ledger

Amount Type

Currency

Currency Type

Value

Note:

Run the report either for a year or for any quarter of a year.

Actual

Vision Operation

Note:

Run the report for any ledger.

Base

MXN

Entered

Chapter 1
Financials for Mexico

49. Set the grid properties. Select the grid to open the Grid Properties dialog box. In the Suppression region, check

the following check boxes:

o Basic Options

o |If Zero, Suppress

o If Missing, Suppress

o If Error, Suppress
50. Save the report.

ORACLE
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Example of the final output of the report:

LI | e |

f

A B

. |Version="1.3"
. |RFC="CRAD407011I5"

| Mes="02"
. | Anio="2019"
i :TIpGEﬂVIU="N'

FechaModBal=""

I Sello="Seal"
i lnaCer‘ﬁﬁcado="1 3"

Cerificado="cERT"

MumCta Saldo Ini
1010101 15,000.00
M11120101 598,094.00
"1120303 290,359.00
r

11120304 13.812.71200
"1120305 5,000.00
M1120313 385,994 00
M1120314 7.201,330.00
L
|1 120605 68.056,851.00

3

Balanza SAT ENR1

C
Debe
0.00
0.00
42 680.134.00

2125429.167.00
0.00

70.000.00
1.275.200.00

5331,226.468.00

e
)

D
Haber
0.00
0.00
42 950,526.00
212731255300
0.00
0.00
168.279.00

5,382.101,665.00

Chapter 1
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Salde Fin
15,000.00
598.094.00
19.967.00

11.923.326.00
5.000.00
455.994.00
8.308.251.00

17,181.654.00

Convert the Trial Balance Report for Mexico to XML Format

You can view the Trail Balance Report for Mexico from the Financial Reporting Center. After you have viewed the report,
you can convert it to an XML format to upload it to the Tax Administration Services (SAT) internet portal.

View the Trial Balance Report for Mexico
You can view the Trail Balance Report for Mexico from the Financial Reporting Center.

Follow these steps:

1. Sign in the Oracle Fusion Cloud Applications.

2. On the home page of General Account Manager, select General Accounting: Financial Reporting Center, My
Folders, Trial Balance Report for Mexico.

W

View the report in HTML.

4. Click the HTML Preview list at the beginning of the page and select Export to Excel.

The report opens in Microsoft Excel.
5. Save the report in your local folder as an Excel Macro-Enabled Workbook.

ORACLE

20



Oracle Fusion Cloud Financials
Using Financials for the Americas

Convert the Trial Balance Report for Mexico to XML Format
You can convert your report to an XML format that can be uploaded to the SAT portal.

Follow these steps:

1.

Open the report in Microsoft Excel and click the View tab.
Click Macros, View Macros.
Enter GenerateXML in the Macro name field and click Create.

The Microsoft Visual Basic editor opens.

Copy and paste the following report conversion code in the Microsoft Visual Basic editor.

Sub GenerateXML ()

Al

' GenerateXML Macro

Dim Version As String

Dim RFC As String

Dim Mes As String

Dim Anio As String

Dim TipoEnvio As String
Dim FechaModBal As String
Dim Sello As String

Dim noCertificado As String
Dim BalanzaCertificado As String
Dim XML As String

Dim XML2 As String

Dim Row As String

Dim Row2 As String

Dim ColumnName As String
Dim ColumnValue As String
Dim MesPl As String

Dim MesP2 As String

Dim Pos As Integer

Dim Pos2 As Integer

Dim Pos3 As Integer

Dim MidStr As String

Dim MidStr2 As String
Dim Arr

Sheets (1) .Select

Version = Replace (ActiveSheet.Cells(1l, 1).Value, " ", "")

RFC = Replace (ActiveSheet.Cells(2, 1).Value, " ", "")

Mes = Replace (ActiveSheet.Cells(3, 1) .Value, " ", "")

Anio = Replace (ActiveSheet.Cells (4, 1) .Value, " ", "")

TipoEnvio = Replace (ActiveSheet.Cells (5, 1).Value, " ", "")
FechaModBal = Replace (ActiveSheet.Cells(6, 1).Value, " ", "")

Sello = Replace (ActiveSheet.Cells (7, 1).Value, " ", "")
noCertificado = Replace (ActiveSheet.Cells (8, 1) .vValue, " ", "")
BalanzaCertificado = Replace (ActiveSheet.Cells (9, 1).Value, " ", "")

Arr = Array("Version", "RFC", "Mes", "Anio", "TipoEnvio", "FechaModBal", "Sello",

"Certificado")
MesPl = Mid(Mes, 6, 3)

If MesPl = "Jan" Then

Mes = "Mes=" & Chr(34) & "01" & Chr(34)
ElseIf MesPl = "Feb" Then

Mes = "Mes=" & Chr(34) & "02" & Chr(34)
ElseIf MesPl = "Mar" Then

Mes = "Mes=" & Chr(34) & "03" & Chr(34)
ElseIf MesPl = "Apr" Then

ORACLE
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"noCertificado",
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Mes = "Mes=" & Chr(34) & "04" Chr (34)
ElseIf MesPl = "May" Then

Mes = "Mes=" & Chr(34) & "05" Chr (34)
ElseIf MesPl = "Jun" Then

Mes = "Mes=" & Chr(34) & "06" Chr (34)
ElseIf MesPl = "Jul" Then

Mes = "Mes=" & Chr(34) & "07" Chr (34)
ElseIf MesPl = "Aug" Then

Mes = "Mes=" & Chr(34) & "08" Chr (34)
ElseIf MesPl = "Sep" Then

Mes = "Mes=" & Chr(34) & "09" & Chr(34)
ElseIf MesPl = "Oct" Then

Mes = "Mes=" & Chr(34) & "10" & Chr(34)
ElseIf MesPl = "Nov" Then

Mes = "Mes=" & Chr(34) & "11" & Chr(34)
ElseIf MesPl = "Dec" Then

Mes = "Mes=" & Chr(34) & "12" & Chr(34)
Else

Mes = "Mes=" & Chr(34) & "13" & Chr(34)
End If

'XML = XML & "<BCE:Balanza xmlns:BCE=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.0rg/2001/XMLSchema-instance"

& Chr(34) & " xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion/

BalanzaComprobacion 1 1.xsd" & Chr(34) & " " & Version & " " & RFC & " " & Mes & " " & Anio & " " &
TipoEnvio & " " & FechaModBal & " " & Sello & " " & noCertificado & " " & BalanzaCertificado & ">" &
vbNewLine

XML = XML & "<BCE:Balanza xmlns:BCE=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/
BalanzaComprobacion" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.0rg/2001/XMLSchema-instance"
& Chr(34) & " xsi:schemalocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1l 1/
BalanzaComprobacion http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/BalanzaComprobacion/
BalanzaComprobacion 1 1.xsd" & Chr(34)

XML2 = XML

Row2 = ""

For I =1 To 9

Pos = (InStr(l, Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Chr(34))) + 1
Pos2 = InStr(Pos, Replace(ActiveSheet.Cells(I, 1).Value, " ", ""), Chr(34))
Pos2 = Pos2 - Pos

Pos3 = 3

MidStr = Mid(Replace (ActiveSheet.Cells(I, 1) .Value, " ", ""), Pos, Pos2)
MidStr2 = Mid(Replace (ActiveSheet.Cells (I, 1).Value, " ", ""), 1, Pos3)

If MidStr <> "" Then

If MidStr2 = "Mes" Then

Row2 = Row2 & " " & Mes

Else

Row2 = Row2 & " " & Replace (ActiveSheet.Cells (I, 1).Value, " ", "")
End If

End If

Next I

XML2 = XML2 & Row2

XML = XML2 & ">" & vbNewLine
ActiveSheet.Range ("Al0") .Select
Selection.End (x1Down) .Select
SheetLastRow = ActiveCell.Row
ActiveSheet.Range ("Al10") .Select

Selection.End (x1ToRight) .Select
SheetLastColumn = ActiveCell.Column

22
ORACLE



Oracle Fusion Cloud Financials Chapter 1
Using Financials for the Americas Financials for Mexico

For I = 11 To SheetLastRow

Row vbTab & "<BCE:Ctas "

For J = 1 To SheetLastColumn

ColumnName = Replace (ActiveSheet.Cells (10, J).Value, " ", "")
ColumnValue = ActiveSheet.Cells (I, J) .Value

Row = Row & ColumnName & "=" & Chr(34) & ColumnValue & Chr(34) & " "
Next J

Row = Row & "/>" & vbNewLine

XML = XML & Row
Next I

XML = XML & "</BCE:Balanza>"
fileSaveName = Application.GetSaveAsFilename (ActiveSheet.Name, fileFilter:="XML Files (*.xml), *.xml")

Open fileSaveName For Output As #1
Print #1, "<?xml version=" & Chr(34) & "1.0" & Chr(34) & " encoding=" & Chr(34) & "UTF-8" & Chr(34) &
nosn

Print #1, XML
Close #1

End Sub

5. Click File > Save.

Save the file in your local folder and close Microsoft Visual Basic.

Select the GenerateXML macro and click Run that appears on the Macros dialog box in Microsoft Excel.
Save the XML file in your local folder.

Open the XML file and verify the output.

®No

Auxiliary Report for Mexico

This topic contains summary information about the Auxiliary Report for Mexico.

Overview

The Auxiliary Report for Mexico helps with an in-depth analysis of all accounting entries for a given account in a given
period. The report displays beginning and ending balance, as well as the daily journals entries posted to that account
during the period.

Key Insights

To run the report, you must first grant access to the user for the Journals for Mexico process so that you can run it from
the Scheduled Processes page. For more information, see Enable the Mexican Reporting Processes.

After generating the report in OTBI, convert the report to an XML format before uploading it to the Tax Administration
Services (SAT) website. You can create the report once and use it periodically.

To use this report with the Legal Entity filter, you must set the Sequencing By option in Specify Ledger Options to Legal
Entity and create the accounting sequences with Legal Entity information.

Frequently Asked Questions

The following table lists frequently asked questions about the Auxiliary Report for Mexico.
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FAQs Answer
How do | find this report? In Oracle Transactional Business Intelligence, select Analysis from Analysis and Interactive Reporting.
Who uses this report? - Financial Accountants

Financial Specialists

When do | use this report? Use the Auxiliary Report for Mexico when you need to provide detailed records of your accounts to the
fiscal authorities.

What type of report is this? Oracle Transaction Business Intelligence

Related Topics
» Generate the Auxiliary Report for Mexico

« Convert the Auxiliary Report for Mexico to an XML Format

Configure the General Ledger Segments for Reporting in OTBI

Before you generate the Auxiliary Report for Mexico, you need to configure and enable the general ledger segments for
reporting in OTBI.

Perform the following tasks to configure and enable general ledger segments for reporting:

1. Enable the chart of accounts segments for Bl reporting.

2. Map the accounting segments with the corresponding Bl Object Name.

3. Deploy flexfields.

4. Run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence process.

Note: Ensure that you configured the chart of accounts. For details about how to configure the chart of accounts, see
How You Configure Chart of Accounts for Mexico Report topic.

Enable the Chart of Accounts Segments

You must enable your accounting segments for OTBI reporting before using them. Perform the following steps to use
the accounting segments in OTBI:

1. Navigate to Setup and Maintenance work area.

2. Select an implementation project.

3. Inthe Task Lists and Tasks section, select Financials > Define Common Applications Configurations for
Financials > Define Common Reference Objects for Financials > Manage Key Flexfields .

The Manage Key Flexfields page appears.
Enter GL# in the Key Flexfield Code field and click Search.
Click Manage Structure Instances.

v oA

The Manage Key Flexfield Structure Instances page appears.
6. Use the search fields to search for your key flexfield structure instances.
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7.
8.

10.

1.
12.
13.

Select your key flexfield structure instances from the Search Results.
Click the Actions menu and then click Edit.

The Edit Key Flexfield Structure Instance page appears.
Select the segment instance that you want to use in OTBI from the Segment Instances table.
Click the Actions menu and then click Edit.

The Edit Key Flexfield Segment Instance dialog box appears.

Select the Bl enabled check box and click the OK\ button.

Click Save.

Repeat the steps for all the segment instances that you want to use in OTBI.

Map the Accounting Segments and Bl Object Name

Populate the Bl Object Name for each of the Segment Labels that want to use in OTBI for reporting and analysis. The Bl
metadata has ten predefined Bl Objects for the different GL segments. These Bl Objects are used as dimensions in OTBI
for the selected GL segments.

Perform the following steps to map the different chart of account segments to the predefined Bl objects:

1.
2.
3.

Navigate to Setup and Maintenance work area.
Select an implementation project.

In the Task Lists and Tasks section, select Financials > Define Common Applications Configurations for
Financials > Define Common Reference Objects for Financials > Manage Key Flexfields .

The Manage Key Flexfields page appears.
Enter GL# in the Key Flexfield Code field and click Search.
Click the Actions menu and then click the Manage Segment Labels option.

The Manage Segment Labels page appears.

Update the Bl Object Name for all the segment labels that are required. For the following three segment label
codes, specify the Bl Object name as specified in the table. Do not modify the Bl object name; use the Bl object
name as mentioned in the following table.

Segment Label Code Bl Object Name

FA_COST_CTR Dim - Cost Center
GL_BALANCING Dim - Balancing Segment
GL_ACCOUNT Dim - Natural Account Segment

7. For the other non-qualified segment labels that you want to use in OTBI, use any Bl object names from Dim -

GL Segment1to Dim - GL Segment10.
For the Auxiliary report for Mexico, map the segment label MX_SUBACCOUNT to Dim - GL Segment9.
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Deploy Flexfields

Perform the following steps to deploy the flexfields:

1. Navigate to Setup and Maintenance work area.
2. Inthe Setup and Maintenance work area, go to the following:

o Offering: Financials
o Functional Area: Financial Reporting Structures
o Task: Manage Chart of Accounts Structure

3. On the Manage Chart of Accounts Structure page, enter GL# in the Key Flexfield Code field and click Search.
4. Click Deploy Flexfield.

The GL#: Processing dialog box appears indicating the deployment progress.
5. Click the OK button after the deployment completes.

Run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence
Process

Perform the following steps to run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence
process:

1. Navigate to the Scheduled Processes work area.
2. Click the Schedule New Process button.

The Schedule New Process dialog box appears.
Click Name.
Click Search.

The Search and Select dialog box appears.

Enter Import Oracle Fusion Data Extensions for Transactional Business Intelligence in the Name field.
Click Search.

Select the process name from the Search Results area and click the OK button.

Click the OK button on the Schedule New Process dialog box.

Pw

O No W,

The Process Details dialog box appears.
9. Update the details and click the Submit button.
10. Note the Process ID and click OK to acknowledge that your process was submitted.
11. Note the status of your process:

o If the status of the process is Succeeded, the process executed successfully. Proceed and generate the
Auxiliary Report for Mexico.
o If the status of the process is failed, check the log file, make corrections, and submit the process again.

Generate the Auxiliary Report for Mexico

The Auxiliary Report for Mexico provides a detailed analysis of all accounting entries for a given account during a given
period. The report displays beginning and ending balances, as well as the daily journal entries posted to an account
during a specific period.
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Use the Auxiliary Report for Mexico to provide detailed records of your accounts to the fiscal authorities.

Prerequisites
Complete these steps before you generate the Auxiliary Report for Mexico:

Sign in to Oracle Transactional Business Intelligence.

Click Catalog.

Click New, Folder on the catalog tool bar.

Create a local folder in My Folders.

Enter the Name of the folder as Mexico and click OK.

The new folder appears in the folder pane in My Folders.

Select the Mexico folder and click the Expand icon.

Click the New icon that appears on the toolbar.

Click the Analysis option that appears in Analysis and Interactive Reporting.
Enter this SQL statement in the Create Analysis from Simple Logical SQL option:

SELECT NumCta saw_0, DesCta saw_2, SaldoIni saw_4, SaldoFin saw 5, Fecha saw_6, NumUnIdenPol saw 7,
Concepto saw_8, Debe saw_9, Haber saw_10, Accounting Period saw_11, Ledger saw_12, Legal Entity saw_13
FROM (SELECT
"General Ledger - Transactional Balances Real Time"."Account"."General Ledger Code Combination
Identifier" bal_ccid,

"General Ledger - Transactional Balances Real Time"."Ledger".'"Ledger Name" Ledger,

"General Ledger - Transactional Balances Real Time".'"Time"."Fiscal Period" Accounting Period,
"General Ledger - Transactional Balances Real Time".'"Natural Account Segment"."Account Code" NumCta,
"General Ledger - Transactional Balances Real Time"."Natural Account Segment"."Account Description"

VAEAUWNRA

00ON0o

DesCta,

"General Ledger - Transactional Balances Real Time"."- Balance".'"Beginning Balance" Saldolni,
"General Ledger - Transactional Balances Real Time"."- Balance"."Ending Balance" SaldoFin,

"General Ledger - Transactional Balances Real Time"."- Balance".'"Period Net Activity" bal_periodbal

FROM "General Ledger - Transactional Balances Real Time" where "General Ledger - Transactional Balances
Real Time"."Ledger"."Ledger Name" in ('@{p_ledger}') and "General Ledger - Transactional Balances Real
Time"."Time"."Fiscal Period" in ('Q@{p_period}') ) balances full outer join (SELECT

"General Ledger - Journals Real Time"."- Header Details"."Header Default Effective Date" Fecha,
"General Ledger - Journals Real Time"."- Account"."General Ledger Code Combination Identifier"
jrnl_ccid,
CONCAT (REPLACE ("General Ledger - Journals Real Time"."- Header Details"."Header Name",'
',"'') ,CONCAT (REPLACE (CAST ("General Ledger - Journals Real Time"."- Header Details"."Header Key" AS
CHAR),' ',''),CONCAT (REPLACE ("General Ledger - Journals Real Time"."- Batch Details"."Batch Name",'
',"'"') ,REPLACE ("General Ledger - Journals Real Time"."- Header Details"."Header Description",' ','"'))))
jrnl_header_desc,

CONCAT (SUBSTRING (REPLACE ("General Ledger - Journals Real Time"."- Header Details"."Header Name",'
','') FROM 1 FOR (50 - CHAR LENGTH (REPLACE (CAST ("General Ledger - Journals Real Time".'"- Header
Details"."Header Key" AS CHAR),' ','')))),REPLACE (CAST ("General Ledger - Journals Real Time"."- Header
Details"."Header Key" AS CHAR),' ','')) NumUnIdenPol,
"General Ledger - Journals Real Time"."- Ledger".'"Ledger Name" jrnl_ ledger,
"General Ledger - Journals Real Time"."Time"."Fiscal Period" jrnl period,
"General Ledger - Journals Real Time"."- Line Details"."Line Description" Concepto,
"General Ledger - Journals Real Time"."- Line Details"."Line Number" jrnl line number,
"General Ledger - Journals Real Time"."- Lines"."Journal Line Accounted Amount Debit" Debe,
"General Ledger - Journals Real Time"."- Lines"."Journal Line Accounted Amount Credit" Haber,
"General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" Legal Entity

FROM "General Ledger - Journals Real Time"

where "General Ledger - Journals Real Time".'"- Ledger"."Ledger Name" in ('@{p_ledger}')

and "General Ledger - Journals Real Time"."Time"."Fiscal Period" in ('@{p_period}')

and "General Ledger - Journals Real Time"."Posting Status"."Posting Status Code" = 'P'

and DESCRIPTOR IDOF ("General Ledger - Journals Real Time"."Balance Subtype".'"Balance Subtype Name") =
IAI

and "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" in

('@{p_legal_entity}')) journals on journals.jrnl_ ledger = balances.Ledger
and balances.bal_ccid = journals.jrnl_ccid
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10.
n.

12.

13.
14.

15.

16.
17.
18.
19.

20.
21.

22.

23,
24.
25.
26.

27.
28.

29.

30.
31.
32.

and journals.]jrnl period = balances.Accounting Period
ORDER BY saw_0,saw_4, saw_5, saw_6, saw_9, saw_10, saw_l11
Click OK.

Click the Prompts tab.

Create two prompts for Ledger and Accounting Period.
Click the Add icon > Column Prompts > "Ledger"."Ledger".

The New Prompt: Ledger dialog box appears.
Click Options on the New Prompt: Ledger dialog box.
Enter SQL Results in the Choice List Values field.

A default query appears in the SQL statement box.
Replace the default query with the following query:

SELECT "General Ledger - Journals Real Time"."- Ledger".'"Ledger Name" FROM "General Ledger - Journals
Real Time" ORDER BY 1 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY

Enter Presentation Variable in the Set a variable field.

Enter p_ledger as the presentation variable.

Click OK.

Click Add > Column Prompt > "Accounting_Period" . "Accounting_Period".

The New Prompt: Accounting_Period dialog box appears.
Click Options on the New Prompt: Accounting_Period dialog box.
Enter SQL Results in the Choice List Values field.

A default query appears in the SQL statement field.
Replace the default query with the following query:

SELECT "General Ledger - Journals Real Time"."Time"."Fiscal Period" s_1, SORTKEY ("General Ledger -
Journals Real Time"."Time"."Fiscal Period") s_2 FROM "General Ledger - Journals Real Time" ORDER BY 1,2
ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY

Enter Presentation Variable in the Set a variable field.

Enter p_period as the presentation variable.

Click OK.

Click Add > Column Prompt > "Legal_Entity" . "Legal_Entity".

The New Prompt: Legal_Entity dialog box appears.
Click Options on the New Prompt: Legal_Entity dialog box.
Enter SQL Results in the Choice List Value box.

A default query appears in the SQL statement box.
Remove the default query and enter the following query:

SELECT "General Ledger - Journals Real Time"."- Header Details"."Journal Legal Entity" FROM "General
Ledger - Journals Real Time" ORDER BY 1 ASC NULLS LAST FETCH FIRST 65001 ROWS ONLY

Enter Presentation Variable in the Set a Variable box.
Enter p_legal_entity as the presentation variable.
Click OK.
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Generating the Auxiliary Report for Mexico

After completing the prerequisites, perform these steps to run the report. Select your ledger and accounting period
every time you run the report.

Sign in to Oracle Transactional Business Intelligence.

Click Catalog.

Navigate and select the Mexico folder in My Folders.

Click Open to open the Balance Journals Detail report.

Specify the ledger and accounting period in the Ledger and Accounting Period fields.
Click OK.

The report appears in a tabular format.

The report excludes encumbrance accounting journal entries.

CUuhWUNA

Convert the Auxiliary Report for Mexico to an XML Format

To upload the Auxiliary Report for Mexico to the Tax Administration Services (SAT) website, you must first convert the
report into an XML format.

To convert the report, perform these steps:

1. Run the Auxiliary Report Mexico report in Oracle Analytics Publisher.

Export the report to Microsoft Excel.
2. C(lick the Export option, select Data, and then select CSV Format.
3. On the Opening Balance Journals Details with Prompts dialog box, select the Open with option and click OK.

The report appears in Microsoft Excel.
4. C(lick the View tab.
Click Macros > Record Macros.

The Record Macros dialog box appears.
Click OK.

Click the View tab.

Click Macros > View Macros.

Click Edit on the Macros dialog box.

Microsoft Visual Basic editor appears.
10. Replace the existing code with the following code:

Sub MakeXML ()

' create an XML file from an Excel table

Dim MyRow As Long, MyCol As Long, MyColStart As Long, MyColEnd As Long, MyCol2 As Long, Temp As String,
YesNo As Variant, DefFolder As String

Dim XMLFileName As String, XMLRecBuffer As String, XMLRec2Buffer As String, MyLF As String, RTC1l As Long
Dim RangeOne As String, RangeTwo As String, Tt As String, FldName (99) As String, CheckFlag As Long, Arr
Dim Version As String, RFC As String, Mes As String, Anio As String, TipoSolicitud As String, NumOrden

L4

VP3O

As String

Dim NumTramite As String, Sello As String, noCertificado As String, Certificado As String, lastRow As
Long

Dim XML As String, MidStr As String, Row As String, XML3 As String, XML4 As String, Pos As String, Pos2
As String
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Dim £sT As Object

'Create stream object

Set f£sT = CreateObject ("ADODB.Stream")
'save text/string data

£sT.Type = 2

'Specify charset for the source text data
£sT.CharSet = "utf-8"

MyLF = Chr(10) & Chr(13) ' a line feed command

YesNo = MsgBox("This procedure requires the following data:" & MyLF _
& "1 A filename for the XML file" & MyLF _

"2 Version Value" & MyLF _

"3 RFC Value" & MyLF _

"4 Mes Value" & MyLF _

"5 Anio Value" & MyLF _

"6 TipoSolicitud Value" & MyLF _

"7 NumOrden Value" & MyLF _

"8 NumTramite Value" & MyLF _

"9 Sello Value" & MyLF _

"10 noCertificado Value" & MyLF _

"1l Certificado Value" & MyLF _

"Are you ready to proceed?", vbQuestion + vbYesNo, "MakeXML CiM")

AR R R R R

If YesNo = vbNo Then

Debug.Print "User aborted with 'No'"
Exit Sub

End If

XMLFileName = FillSpaces (InputBox("l. Enter the name of the XML file:", "MakeXML CiM", "xl1 xml data"))
If Right (XMLFileName, 4) <> ".xml" Then

XMLFileName = XMLFileName & ".xml"

End If

If Len(Dir("C:\Mexico", vbDirectory)) = 0 Then
MkDir "C:\Mexico"
End If

If Len(Dir("C:\Mexico\Auxiliary", vbDirectory)) = 0 Then
MkDir "C:\Mexico\Auxiliary"
End If

DefFolder = ActiveWorkbook.Path
'"c:\Mexico\Auxiliary"
'InputBox ("2. Enter the location of the path for the output file", "MakeXML CiM", "Enter the Path")
RangeOne = "Al:K1"
If MyRng(RangeOne, 1) <> MyRng(RangeOne, 2) Then
MsgBox "Error: names must be on a single row" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
"MakeXML CiM"
Exit Sub
End If
MyRow = MyRng (RangeOne, 1)
For MyCol = MyRng(RangeOne, 3) To MyRng(RangeOne, 4)
If Len(Cells (MyRow, MyCol) .Value) = 0 Then
MsgBox "Error: names range contains blank cell" & MyLF & "Procedure STOPPED", vbOKOnly + vbCritical,
"MakeXML CiM"

Exit Sub
End If
FldName (MyCol - MyRng(RangeOne, 3)) = FillSpaces (Cells (MyRow, MyCol) .Value)
Next MyCol
'RangeTwo = InputBox("3. Enter the range of cells containing the data table:", "MakeXML CiM", "A2:I2")

lastRow = ActiveSheet.Cells (Rows.Count, "A") .End(x1Up) .Row

RangeTwo = "A2:K" & lastRow
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If MyRng(RangeOne, 4) - MyRng(RangeOne, 3) <> MyRng(RangeTwo, 4) - MyRng(RangeTwo, 3) Then
MsgBox "Error: number of field names <> data columns" & MyLF & "Procedure STOPPED", vbOKOnly +
vbCritical, "MakeXML CiM"

Exit Sub
End If
RTC1 = MyRng(RangeTwo, 3)

Version = InputBox("2. Enter the Version Value:", "MakeXML CiM", "1.3")
Version = "Version=" & Chr(34) & Version & Chr(34)

RFC = InputBox("3. Enter the RFC Value:", "MakeXML CiM", "RFC Value")
RFC = "RFC=" & Chr(34) & RFC & Chr (34)

Mes = InputBox("4. Enter the Mes Value:", "MakeXML CiM", "Mes Value")
Mes = "Mes=" & Chr(34) & Mes & Chr(34)

Anio InputBox ("5. Enter the Anio Value:", "MakeXML CiM", "Anio Value")
Anio = "Anio=" & Chr(34) & Anio & Chr(34)

TipoSolicitud = InputBox("6. Enter the TipoSolicitud Value:", "MakeXML CiM", "TipoSolicitud Value")
TipoSolicitud = "TipoSolicitud=" & Chr(34) & TipoSolicitud & Chr(34)

NumOrden = InputBox("7. Enter the NumOrden Value:", "MakeXML CiM", "NumOrden Value")
NumOrden = "NumOrden=" & Chr(34) & NumOrden & Chr (34)

NumTramite = InputBox("8. Enter the NumTramite Value:", "MakeXML CiM", "NumTramite Value")
NumTramite = "NumTramite=" & Chr(34) & NumTramite & Chr(34)

Sello InputBox("9. Enter the Sello Value:", "MakeXML CiM", "Sello Value")
Sello = "Sello=" & Chr(34) & Sello & Chr(34)

noCertificado = InputBox("10. Enter the Certificado Number Value:", "MakeXML CiM", "noCertificado
Value")
noCertificado = "noCertificado=" & Chr(34) & noCertificado & Chr (34)

Certificado = InputBox("1ll. Enter the Certificado Value:", "MakeXML CiM", "Certificado Value")
Certificado = "Certificado=" & Chr(34) & Certificado & Chr(34)

Arr = Array(Version, RFC, Mes, Anio, TipoSolicitud, NumOrden, NumTramite, Sello, noCertificado,
Certificado)

If InStr(l, XMLFileName, ":\") = 0 Then
XMLFileName = DefFolder & "\" & XMLFileName
End If

XMLRecBuffer = " <AuxiliarCtas:Cuenta "
CheckFlag = 0

'XML3 = "<AuxiliarCtas xmlns:xsi=" & Chr(34) & "http://www.w3.0rg/2001/XMLSchema-instance" & Chr(34) & "
xsi:schemaLocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas http://

www.sat.gob.mx/esquemas/ContabilidadE/1_1/AuxiliarCtas/AuxiliarCtas 1 1.xsd" & Chr(34) & " xmlns=" &
Chr(34) & "http://www.sat.gob.mx/esquemas/ContabilidadE/l_1/AuxiliarCtas" & Chr(34) & " Version=" &
Chr(34) & Version & Chr(34) & " RFC=" & Chr(34) & RFC & Chr(34) & " Mes=" & Chr(34) & Mes & Chr(34)
& " Anio=" & Chr(34) & Anio & Chr(34) & " TipoSolicitud=" & Chr(34) & TipoSolicitud & Chr(34) & "
NumOrden=" & Chr(34) & NumOrden & Chr(34) & " NumTramite=" & Chr(34) & NumTramite & Chr(34) & " Sello="
& Chr(34) & Sello & Chr(34) & " noCertificado=" & Chr(34) & noCertificado & Chr(34) & " Certificado=" &
Chr (34) & Certificado & Chr(34) & ">"

XML3 = "<AuxiliarCtas:AuxiliarCtas xmlns:AuxiliarCtas=" & Chr(34) & "http://www.sat.gob.mx/esquemas/

ContabilidadE/1_3/AuxiliarCtas" & Chr(34) & " xmlns:xsi=" & Chr(34) & "http://www.w3.org/2001/

XMLSchema-instance" & Chr(34) & " xsi:schemalocation=" & Chr(34) & "http://www.sat.gob.mx/esquemas/

ContabilidadE/1l_3/AuxiliarCtas http://www.sat.gob.mx/esquemas/ContabilidadE/1_3/AuxiliarCtas/

AuxiliarCtas_1 3.xsd" & Chr(34)

XML4 = XML3

Row = ""
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'Open XMLFileName For Output As #1
'Open the stream and write binary data to the object
£sT.Open

For I = 0 To 9

Pos = InStr(l, Arr(I), Chr(34))

Pos2 = InStrRev(Arr(I), Chr(34), -1)
Pos2 = Pos2 - Pos

MidStr = Mid(Arr(I), (Pos + 1), (Pos2 - 1))
'MsgBox MidStr

If MidStr <> "" Then
Row = Row & " " & Arr(I)
End If

Next I

XML4 = XML4 & Row

XML3 = XML4 & ">"

'Open XMLFileName For Output As #1

fsT.writetext "<?xml version=" & Chr(34) & "1.0" & Chr(34) & " encoding=" & Chr(34) & "UTF-8" & Chr(34)
& "?>" & Chr(13) & Chr(10)

fsT.writetext XML3 & Chr(13) & Chr(10)

If FldName(l) = "SubCta" Then

MyColStart = 7

Else

MyColStart = 5
End If
If FldName (1) = "SubCta" Then

MyColEnd = 0

Else

MyColEnd = 2
End If

'MsgBox MyRng (RangeTwo, 4)

'MsgBox MyColStart

'MsgBox FldName (1)
For MyRow = MyRng(RangeTwo, 1) To MyRng(RangeTwo, 2)

For MyCol = RTCl To MyRng(RangeTwo, 4) - MyColEnd

If MyCol = MyColStart And CheckFlag = 0 Then

'MsgBox XMLRecBuffer

fsT.writetext XMLRecBuffer & ">" & Chr(13) & Chr(10)

CheckFlag = 1

End If

If MyCol = MyColStart Then

XMLRec2Buffer = " <AuxiliarCtas:DetalleAux "

For MyCol2 = MyCol To MyRng(RangeTwo, 4) - MyColEnd

If RemoveAmpersands (FormChk (MyRow, MyCol2)) <> "" Then

XMLRec2Buffer = XMLRec2Buffer & " " & FldName (MyCol2 - 1) & "=" & Chr(34) &
RemoveAmpersands (FormChk (MyRow, MyCol2)) & Chr (34)

ElseIf FldName (MyCol2 - 1) = "Debe" Or FldName (MyCol2 - 1) = "Haber" And
RemoveAmpersands (FormChk (MyRow, MyCol2)) = "" Then

XMLRec2Buffer = XMLRec2Buffer & " " & FldName (MyCol2 - 1) & "=" & Chr(34) & "O" & Chr(34)
End If

' the next line uses the FormChk function to format dates and numbers

' the next line does not apply any formatting

' £sT.writetext "<" & FldName (MyCol - RTCl) & ">" & RemoveAmpersands (Cells (MyRow, MyCol) .Value) & "</"
& FldName (MyCol - RTCl) & ">" & Chr(13) & Chr(10)

Next MyCol2

fsT.writetext XMLRec2Buffer & "/>" & Chr(13) & Chr(10)

End If

' the next line uses the FormChk function to format dates and numbers

' the next line does not apply any formatting

' f£sT.writetext "<" & FldName (MyCol - RTCl) & ">" & RemoveAmpersands (Cells (MyRow, MyCol) .Value) & "</"
& FldName (MyCol - RTC1l) & ">" & Chr(13) & Chr(10)
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If CheckFlag = 0 Then

If RemoveAmpersands (FormChk (MyRow, MyCol)) <> "" Then

If FldName (MyCol - RTCl) = "Debe" Or FldName (MyCol - RTC1l) = "Haber" Then

XMLRecBuffer = XMLRecBuffer & " " & FldName (MyCol - RTCl) & "=" & Chr(34) & "O" & Chr(34)
ElseIf FldName (MyCol - RTCl) = "NumCta" And FldName(l) = "SubCta" Then

If RemoveAmpersands (FormChk (MyRow, MyCol + 1)) <> "" Then

XMLRecBuffer = XMLRecBuffer & " " & FldName (MyCol - RTCl) & "=" & Chr(34) &
RemoveAmpersands (FormChk (MyRow, MyCol)) & "-" & RemoveAmpersands (FormChk (MyRow, MyCol + 1)) & Chr (34)
Else

XMLRecBuffer = XMLRecBuffer & " " & FldName (MyCol - RTCl) & "=" & Chr(34) &
RemoveAmpersands (FormChk (MyRow, MyCol)) & Chr (34)

End If

ElseIf FldName (MyCol - RTC1l) = "DesCta" And FldName (1) = "SubCta" Then

If RemoveAmpersands (FormChk (MyRow, MyCol + 1)) <> "" Then

XMLRecBuffer = XMLRecBuffer & " " & FldName (MyCol - RTCl) & "=" & Chr(34) &
RemoveAmpersands (FormChk (MyRow, MyCol)) & "-" & RemoveAmpersands (FormChk (MyRow, MyCol + 1)) & Chr(34)
Else

XMLRecBuffer = XMLRecBuffer & " " & FldName (MyCol - RTCl) & "=" & Chr(34) &
RemoveAmpersands (FormChk (MyRow, MyCol)) & Chr (34)

End If

ElseIf FldName (MyCol - RTC1l) = "SubCta" Or FldName (MyCol - RTCl) = "SubDesCta" Then

XML3 = "SubCta"

Else

XMLRecBuffer = XMLRecBuffer & " " & FldName (MyCol - RTCl) & "=" & Chr(34) &

RemoveAmpersands (FormChk (MyRow, MyCol)) & Chr (34)
'MsgBox XMLRecBuffer

End If

End If

End If

Next MyCol

If FormChk (MyRow, 1) <> FormChk (MyRow + 1, 1) Then
fsT.writetext " </AuxiliarCtas:Cuenta>" & Chr(13) & Chr(10)
XMLRecBuffer = " <AuxiliarCtas:Cuenta "

CheckFlag = 0

End If
Next MyRow

fsT.writetext "</AuxiliarCtas:AuxiliarCtas>" & Chr(13) & Chr(10)

'Close #1

'Save binary data To disk

fsT.SaveToFile XMLFileName, 2

MsgBox XMLFileName & " created." & MyLF & "Process finished", vbOKOnly + vbInformation, "MakeXML CiM"
Debug.Print XMLFileName & " saved"

End Sub
Function MyRng (MyRangeAsText As String, MyItem As Long) As Long
' analyse a range, where MyItem represents 1=TR, 2=BR, 3=LHC, 4=RHC

Dim UserRange As Range
Set UserRange = Range (MyRangeAsText)
Select Case MyItem

Case 1

MyRng = UserRange.Row

Case 2

MyRng = UserRange.Row + UserRange.Rows.Count - 1

Case 3

MyRng = UserRange.Column

Case 4

MyRng = UserRange.Columns (UserRange.Columns.Count) .Column
End Select

Exit Function

End Function

Function FillSpaces (AnyStr As String) As String

' remove any spaces and replace with underscore character
Dim MyPos As Long
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MyPos = InStr(l, AnyStr, " ")
Do While MyPos > 0

Mid (AnyStr, MyPos, 1) = "_"
MyPos = InStr(l, AnyStr, " ")
Loop

FillSpaces = AnyStr

End Function

Function FormChk (RowNum As Long, ColNum As Long) As String
' formats numeric and date cell values to comma 000's and DD MMM YY
FormChk = Cells (RowNum, ColNum) .Value
'Tf IsNumeric(Cells (RowNum, ColNum) .Value) Then
' FormChk = Format (Cells (RowNum, ColNum).Value, "#,##0 ; (#, ##0)")
'End If
If IsDate(Cells (RowNum, ColNum) .Value) Then
FormChk = Format (Cells (RowNum, ColNum) .Value, "yyyy-mm-dd")
End If
End Function

Function RemoveAmpersands (AnyStr As String) As String
Dim MyPos As Long
' replace Ampersands (&) with plus symbols (+)

MyPos = InStr(l, AnyStr, "&")
Do While MyPos > 0

Mid (AnyStr, MyPos, 1) = "+"
MyPos = InStr(l, AnyStr, "&")
Loop

RemoveAmpersands = AnyStr
End Function

11. Run the macro.

The MakeXML CiM dialog box appears containing instructions to provide several details in a series of dialog
boxes.

12. Click Yes and proceed with information entry on each dialog box as they appear one after the other. Enter the
following information:
o Name of the output file
o Location to save the file
o Version of the file
o RFC
o Mes
o Anio
o TipoSolicitud
o NumOrden
o NumTramite
o Seal
o Certificate number
o Certificate details

13. Verify the location where the output files will be saved and click OK.

Open the XML report that's saved at location you specified.
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FAQs for General Ledger Reporting

How do parent accounts and subaccounts appear in the Mexico
reports?

If you have a combination of account and subaccount, the SubCtaDe field displays the immediate natural account
preceding a subaccount.

This happens because account hierarchy considers only the immediate natural account preceding the subaccount as
the parent. The original parent account may not always be the immediate parent for a subaccount.

Consider these parent and child natural accounts, and the associated subaccounts, for an example:

Natural Account - Parent Natural Account - Child Subaccount SubCtaDe displays
100 100
100 10001 100 10001
100 10002 100 10002
10002 001 10002 001
10002 002 10002 002

Here, the parent account for the natural child accounts 10001 and 10002 is 100. However, the immediate parent account
for subaccount 001is 10002 and not 100. Since it takes precedence before the natural parent account, the report
displays 10002 001, instead of 100 001.

Why doesn't my report display details of foreign fiscal documents?

You can see details of foreign fiscal documents (CompExt) only on foreign invoices. These details aren't going to show
on your report.
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Why doesn't my RFC appear on the Mexican reports?

If your Taxpayer Identification Registry (RFC) doesn't appear on the Mexican report, try one of these methods:

- To make it appear at the header level:
o Specify it at your legal entity level while you create the legal entity.
- To make it appear at the national fiscal documents of type CFDI (CompNal) level and payment levels:

o Specify it at the supplier level.

How can | retrieve supplier RFC for Mexican reports?

The supplier site tax registration must match with the tax regime of the transaction to retrieve the supplier RFC for
Mexican reports.

If the supplier site tax registration doesn't match, the default supplier site tax registration is used as RFC. If there's no
supplier site tax registration, the supplier profile tax registration that matches the tax regime of the transaction is used
as RFC. If there's no match, the default supplier profile tax registration will be used as RFC.
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2 Financials for Brazil

Fiscal Document Generation

Fiscal Document Generation

A fiscal document is generated to represent sale of goods or services and movement of goods or assets from one
location to another. A fiscal document provides all relevant details of a transaction, including applicable taxes and
associated fiscal attributes.

A fiscal document is created in an XML format and is validated by the tax authorities before it's sent to the customers. It
can also be sent in a paper format, called DANFE, along with the goods.

You can void or cancel a fiscal document within a specified time period. You can also generate an alternate document in
contingency mode, in case there is no response from the tax authority.

You can generate a fiscal document either from the Receivables workflow or Shipment workflow. A receivables invoice
is used to support the generation of a fiscal document for sale of goods, services, or both. From Shipment, you can
generate fiscal documents for internal material transfers and return to supplier transactions.

You can generate a fiscal document only for transactions that are associated with a business unit operating in Brazil.

To correctly generate the fiscal document, ensure the Enable Fiscal Document Processing check box is enabled on the
Localization System Options page. This lets you capture the appropriate fiscal attributes.

After the fiscal document is generated, it can be extracted in an extract file. You can use third party software to interface
the document to the tax authority portal and capture back the approval or rejection status. Alternatively, you can
manually upload the fiscal document to the tax authority portal and update the return status in the Oracle Fusion Cloud
Applications.

A service fiscal document follows a similar flow but it should be approved by a city tax authority, since the service taxes
are collected by cities. For service invoices, separate fiscal documents are generated for each invoice line and handled
individually. Similarly, mixed invoices with goods and service lines will generate one mixed fiscal document that's
submitted to the state or federal tax authority and one service fiscal document for each service line that's submitted to
the city tax authority.

Fiscal Document Generation Statuses

A fiscal document goes through different stages in its life cycle and different statuses are used to track them.

Use the Manage Fiscal Document Generation page to search and track the status of your fiscal document. This page can
be accessed from both the Receivables workflow and Shipment workflow.

Note: You need the Fiscal Document Generation duty role to search and track the fiscal document.
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These table lists the different statuses that can be assigned to a fiscal document:

Status

Transaction Entered

Scheduled

In Process

Validation Errors

Generated

Generated - Contingency

Sent

Approved

Approval Errors

Marked for Cancel

Marked for Void

Canceled

Voided

Upload Failure

Approved with Corrections

Pending Return

Rejected

Notes

When transaction entry is complete.

When fiscal attributes are entered and the transaction is ready for fiscal document generation.

When a record is locked for processing. It is used to restrict changes to the fiscal attributes.

When errors are identified in the fiscal attribute details.

When the fiscal attribute validation is successful and fiscal document number is allocated.

When the fiscal document is generated in contingency mode.

When a fiscal document is made available to the third-party application.

When a fiscal document is approved by the tax authority.

When a fiscal document is rejected by the tax authority because of errors.

When a fiscal document is marked for cancellation.

When a fiscal document is marked for void.

Wen the tax authority approves canceling of a fiscal document.

When the tax authority approves voiding of a fiscal document.

When the third party application reports upload failure to the tax authority site.

When the tax authority approved a fiscal document with certain corrections to the tax amounts.

Status returned by third party application when there is no update from the tax authority.

When the tax authority rejects the fiscal document.

The tax authority can return the fiscal document approval, or can mark the validation errors or can reject the fiscal
document.

If the partner informs there are communication issues with tax authority, the fiscal document can be generated
in contingency mode so goods can be shipped. Besides that, if necessary a fiscal document can be canceled after
receiving an approval from the tax authority or it can be voided before it is sent to the tax authority.
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All these statuses are effectively managed and tracked through the Manage Fiscal Document Generation page.

When a fiscal document represents sale of goods and services through a single transaction, involving reporting and
approval from different tax authorities, a dynamic approval process is built into the application where the approval from
different tax authorities is managed in a queue model, in a synchronous mode.

How You Cancel or Void a Fiscal Document

You can void a fiscal document if you want to report to the tax authority that the fiscal document number will not be
used.

However, this can be done only after the fiscal document is generated and before it is approved by the tax authority. Use
the Void Fiscal Document button on the Manage Fiscal Document Generation page to void a fiscal document.

When a fiscal document is validated and approved by the tax authority, but the goods or services are no longer intended
to be provided or shipped, you can cancel the fiscal document. Use the Cancel Fiscal Document button on the Manage
Fiscal Document Generation page to cancel a fiscal document.

Provide a valid reason to void or cancel a fiscal document. The reason must be notified to the tax authority. A fiscal
document can be considered as canceled or voided only after confirmation from the tax authority. When the tax
authority does not approve the cancellation or voiding of a fiscal document, the status of the fiscal document is
changed back to Approved or Generated.

Note: You can void or cancel a fiscal document within a defined time limit. The time limit within which you can cancel
or void a fiscal document is specified by each tax authority. Use the Party Tax Profile page to set the time limit.

Fiscal Documents for Fixed Assets and Material Transfer

You need to generate a fiscal document when any material or assets move across different locations within an
organization, even though it doesn't involve any sale.

When a fixed asset is transferred from one location to another, a receivables invoice is automatically created for
supporting the creation of a fiscal document. The invoice captures all the transfer details of the asset and has a
transaction type that doesn't post to General Ledger or create open balances in Receivables.

To be able to create a fiscal document for asset transfer across different locations, ensure the:

- Global descriptive flexfields associated with the Asset Book for creating fiscal documents for asset transfers is
enabled.

- Transaction Details section on the Create Fixed Assets Transfer Control page is updated. You can access the
Create Fixed Assets Transfer Control page through the Manage Fiscal Document Generation Controls page.
These transaction details are used for creating the Receivables invoice.

- Source and destination locations have legal reporting units assigned to them. The source and destination legal
reporting units drive the need for creating a fiscal document. Use the Manage Asset Locations task to specify
the legal reporting units.

When these conditions are met, a Receivables invoice is created with details of the fixed asset transfer. The invoice is
then used to generate a fiscal document.
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You can track the Receivables invoices that are created for each fixed asset transfer through the Manage Asset Transfers
Requiring Fiscal Document task.

Similarly, when goods are moved from one warehouse to another, the fiscal document representing the internal material
transfer is generated through the reference of the corresponding shipment.

How You Configure Setup Manager for Fiscal Document
Generation

Use Oracle Financials to generate fiscal documents. You can create a fiscal document, get it validated by the tax
authority, and send it to the customers.

The fiscal document is generated as an XML file and provides all relevant details of a transaction, including applicable
taxes and associated fiscal attributes.

In the Functional Setup Manager, perform these tasks to generate fiscal documents:

- Regional Localization: Regional Localization for Brazil must be enabled within the feature offerings for
Financials. Select Brazil as the Regional Localization in Financials features.

- Localization System Options: For every business unit operating in Brazil, the country field must be updated and
the option for fiscal document processing must be enabled.

Select Brazil as the Country and check the Enable Fiscal Document Processing check box on the Manage
Localization System Options page. This lets you to:

o Capture fiscal attributes for invoice and debit memo in Receivables and for internal material transfer
shipments and return to supplier shipment in Shipments

o Generate and manage fiscal documents.

- Manage Asset Book: Use the Manage Asset Book task to identify the assets within an asset book that require
fiscal document processing.

This set up also enables processing of fiscal document when a fixed asset belonging to an asset book is
transferred.

- Manage Fiscal Document Generation Controls: This setup is used to specify various fiscal document generation
controls, including default fiscal attributes. For fixed assets, this setup specifies the source and destination
legal reporting units between which any transfer of fixed assets will require a fiscal document. It also provides
the details of key attributes required to generate a receivables invoice that supports generation of a fiscal
document.

- Manage Asset Locations: Use the Manage Asset Locations task to specify the legal reporting units that must be
assigned to each location.

Legal reporting units must be assigned to each location, so that transfer of assets across locations can identify
the source and destination legal reporting units.

- Manage Tax Authority Tax Profiles: Use this task to classify a tax authority and to specify the time controls for
performing various actions on a fiscal document like cancel, void, or generate in contingency.

- Configure Taxes: Specify or configure taxes for applying relevant taxes on transactions which support fiscal
document generation. This setup includes usage of key tax determinants like transaction business category,
product category, and product fiscal classification.
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Use National Service Fiscal Documents for Brazil

Work with the recently introduced national system for service fiscal documents in Brazil. This feature provides an option
to users who would like to use the new national system.

The national tax authority processes the national service fiscal document centrally compared to the current service
fiscal document where each city has its own processing and document layout.

To use this option, you must create a new city inscription tax registration using a new Tax Registration Status.

Follow these steps:

Navigate to Manage Standard Lookups and search for the Lookup Type ZX_REGISTRATIONS_STATUS.
Add a new Lookup Code NATIONAL_SERVICE.

Save and Close.

Navigate to Manage Tax Registrations.

Add a new tax registration for a legal reporting unit.

Enter the required data and select the Tax Registration Status that you created.

Save and Close.

NowupuwN

Note: The regular service fiscal document and the national service fiscal document system will not coexist. You
must set the end date for the existing tax registration before you add a new tax registration If you are already using
the regular service fiscal document for the same city, check the migration date with the city tax authority.

8. Create a document sequence and fiscal document generation control for the national service fiscal document.
Results:
The steps to create a national service fiscal document are the same as that of a regular service fiscal document. Here are

some processing differences:

- The national service fiscal document has only a single line hence all receivables transaction lines will be
consolidated in a single line in the fiscal document extract along with respective taxes. By default, the fiscal
document line description will inherit the first transaction line description, but you can provide a more
meaningful description at the Update Fiscal Attributes Ul or in the Import Outbound Fiscal Attributes FBDI.

- The system generates a fiscal document key (DPS Key) after it generates the fiscal document.

- The tax authority returns a service fiscal document key with the fiscal document number upon approval of the
fiscal document.

The national service fiscal document cancellation process follows the same steps as that of a regular service fiscal
document cancellation process.

Related Topics
 Define Localization Document Numbering
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Use the new Model 62 for Generating Fiscal Documents for Brazil

You can create and process a national service fiscal document using the new Model 62 provided by the national tax
authority.

Companies in certain industries, including media and telecommunications, must use this new format in their electronic
fiscal documents. This Model 62 also referred as electronic communication service fiscal document is a replacement for
the models 21 and 22 which will be decommissioned in April 2025.

Note: Model 22 contains detailed information related to landed or mobile phone services and third-party phone
network usage, none of which is supported by Cloud ERP.

1. Prepare Cloud ERP to generate communication service fiscal documents:
a. Create a new document sequence category and document sequence.
b. Create a fiscal document sequence with the new model 62.
In the Create Series dialog box, enter the Series and Series Description, and select the Model as Model
62.
c. Create a document fiscal classification to identify the transactions eligible for communication service fiscal
documents.

d. Create a fiscal document generation control for the communication service fiscal document using the
created document fiscal classification and the Fiscal Document Model type field to identify it

Note: The tax authority allows the creation of a contingency fiscal document for communication service fiscal
document, however, Cloud ERP currently doesn t provide support for this flow. Customers must retry the fiscal
document processing until it's approved by the tax authority.

2. Create a communication service fiscal document:

a. Create a receivables transaction similar to what is required for regular service fiscal documents.

b. Provide the document fiscal classification to identify whether it will be used for a communication service
fiscal document.\

c. After the transaction is created and the fiscal document is requested, you must provide the new specific
fiscal attributes related to a communication service fiscal document:

d. If the Issuing Purpose is Adjustment, you must indicate which previous approved communication service
fiscal document and line are being adjusted.
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3. Use the enhanced fiscal document extract:
These new elements related to communication service fiscal document are implemented in the output file of the
Send Fiscal Document to Tax Authority process:
This image shows the new elements related to communication service fiscal document.
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1D Field Description Parent Type Cardinality
Al FISCAL_DOC_HEADER - GROUP -

- APPROVER_SITE Tax authority approver site used Al MU 1-1
for a communication service
fiscal document approval. The tax
authority will make some sites
available [0 to 9) and user needs
to select one to send the fiscal
document for approval.

- IS5UING_PURPOSE Issuing purpose for a Al CHAR 1-1
comrmunication service fiscal
document.

- BILLING_TYPE Billing type used in a Al CHAR 11
comrmunication service fiscal
document.

- FIRST _PARTY TRIBUTARY REGIME Company Tributary Regime Code. Al CHAR 0-1

- FIRST_PARTY_PHOMNE_MUMEER Company primary contact phone Al CHAR o0-1
number.

- FIRST_PARTY_EMAIL Company primary contact e-mail Al CHAR 0-1
address.

- SHIP_TO_PARTY_SITE_OTHER Ship-to customer taxpayer Id Al CHAR 0-1
with ORA_BR_OTHER type.

- SHIP_TO_PARTY_SITE_IE_CLASS Ship-to customer third-party site Al CHAR 0-1
tax profile with tax reporting
code
ORA_BR_STATE_INSCRIPT_CLASS.

- SHIP_TO_PARTY_PHOME Ship-to customer primary contact Al CHAR 0-1
phone number.

- BILL_TO_PARTY_PHOMNE Bill-to customer primary contact Al CHAR 0-1
phone number.

- BILL_TO _REGISTRY_ID Bill-to customer registry Id. Al CHAR 0-1

- BILL TO CUSTOMER _TYPE Bill-to customer type. Al CHAR 0-1

- CONTRACT_NUMBER Contract number that originated Al CHAR 0-1
the receivables invoice.

- CONTRACT _START_DATE Start date of the contract number Al DATE 0-1
that originated the receivables
invoice.

- CONTRACT_END_DATE End date of the contract number Al DATE 01
that originated the receivables
invoice.

- BILL_TO_PARTY_SITE_DEBIT_REF_ID Customer primary bank account Al CHAR o1
Debit Authorization Reference
Identifier.

- BILL_TO_PARTY_SITE_BANK_CODE Bank code of the customer Al CHAR 01
primary bank account.

- BILL_TO_PARTY_SITE_BRANCH_CODE Branch code of the customer Al CHAR 01
primary bank account.

B3 FISCAL DOC LINES Al GROUP 1-M
- PREV_FISCAL_DOC_KEY Approved Fiscal document key to B3 CHAR 01
be adjusted.

- PREV_FISCAL_DOC_LINE_NUM Approved Fiscal document line to B3 MU 01
be adjusted.
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Related Topics
 Define Localization Document Numbering

Fiscal Document Capture

Overview of Tax Processing for Fiscal Document Capture

In Brazil, a fiscal document is generated for every sale or shipment involving goods or services. The supplier creates this
document, gets it validated by the tax authority and sends it to the customer.

It is generated as an XML file or as a physical document and provides complete details of the transaction along with
applicable taxes.

You can use the fiscal document capture feature to support processing of fiscal documents received from suppliers. The
documents can be received either manually or in an XML format.

You can use fiscal document capture to support the processing of fiscal documents received from suppliers or

third parties. You can enter the documents either manually or import them. Several validations are performed like
comparison with source documents, verification of taxes against the tax setup, confirmation of goods received, and so
on. After the validations, the corresponding receipts and Payables invoice are automatically created on the basis of the
information from the fiscal document.

Complementary fiscal documents, which are used to record corrections in quantity, price, or taxes are also handled by
fiscal document capture. Similarly, freight fiscal documents covering freight charges against multiple deliveries are also
supported.

How Taxes on Fiscal Documents Are Calculated

Fiscal documents issued by suppliers are validated by the tax authority. So, taxes applied on it are treated as source of
truth for accounting and reporting purposes.

During fiscal document capture and processing, taxes are additionally calculated based on tax setup, compared with
the supplier notified taxes and a hold is placed if their difference is beyond tolerance limits. This hold prompts for either
rectification of tax setup (if calculated taxes are incorrect) or for pursuing with the supplier to issue a complementary
fiscal document (if supplier notified taxes are incorrect).

Use the Manage Configuration Owner Tax Options page to specify the tolerance limits for the difference between fiscal
document taxes and calculated taxes. You can use fiscal document capture as the application name.

On the Manage Fiscal Document page, the tax amount notified on the fiscal document is captured in the Fiscal
Document Tax Amount field and the tax amount calculated according to tax setup is displayed in the Tax Amount
field.

These table provides the tax handling approach on an XML imported fiscal document for various scenarios involving
these two attributes:
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Scenario Tax Treatment

Tax is notified on the fiscal document and = Fiscal Document Tax Amount = <Notified Value>
the same is applicable based on tax setup.

Tax Amount= <Calculated Value>

Fiscal document goes on hold if their difference is beyond tolerance limit.
Tax is notified on the fiscal document, but = Fiscal Document Tax Amount = <Notified Value>
it is not applicable based on tax setup.

Tax Amount= 0.00

Fiscal document goes on hold.
Tax is not notified on the fiscal document, = Fiscal Document Tax Amount = 0.00
but it is applicable based on tax setup.

Tax Amount= <Calculated Value>

Fiscal document goes on hold.
Updates are made to the calculated tax Fiscal Document Tax Amount = <Notified Value>
amount

Tax Amount= <Updated Value>

Fiscal document goes on hold if their difference is beyond tolerance limit.

Manual tax line is created Fiscal Document Tax Amount = 0.00
Tax Amount= <Input Value>

Fiscal document goes on hold.

If a fiscal document is received in a physical format, then it is manually entered through the Manage Fiscal Documents
page.

When you click the Calculate Tax or Validate Fiscal Document buttons, taxes are calculated according to the tax setup.
Both the Fiscal Document Tax Amount and Tax Amount attributes display the calculated value, you can review and
correct fiscal document tax amount, if required.

You cannot update the tax information on the fiscal document when the status is Completed Prevalidation.

Regardless of the mode of fiscal document creation, only the taxes captured into Fiscal Document Tax Amount are
processed to downstream transactions.

How Taxes on Complementary Fiscal Documents Are Calculated

You'll learn how taxes are calculated on complementary fiscal documents in this section.

If there is any discrepancy (in price, quantity, or tax) in the fiscal document, the supplier issues a complementary fiscal
document for rectifying it. The Manage Fiscal Document page captures this action as in any regular fiscal document.

The Fiscal Document Tax Amount attribute captures the tax amount notified on the fiscal document and the Tax
Amount attribute captures the amount calculated based on the tax setup.
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This table provides how taxes for different types of imported complementary fiscal documents occur within these
attributes.

Document Type Tax Treatment

Complementary Fiscal Document for Fiscal Document Tax Amount = <Notified Value>
Quantity Correction
Tax Amount = <Calculated Value>

Fiscal document goes on hold if their difference is beyond tolerance limit.

Complementary Fiscal Document for Price  Fiscal Document Tax Amount = <Notified Value>
Correction
Tax Amount = <Fiscal Document Tax Amount>

Complementary Fiscal Document for Tax Fiscal Document Tax Amount = <Notified Value>
Correction
Tax Amount = <Fiscal Document Tax Amount>

When complementary fiscal documents involve price or tax corrections, the tax amount notified in the fiscal document
is also taken as the calculated tax amount, as the transaction information is not sufficient for calculating tax. When such
fiscal documents are received in physical format, you need to enter the tax details manually.

Import Inbound Fiscal Documents

Use the Import Inbound Fiscal Document Attributes Template to populate your Inbound Fiscal Document Attributes and
upload them into Oracle Fusion Cloud Applications. Prepare the required Inbound Fiscal Document Attributes offline in
the applicable spreadsheet templates.

You do not need to access any Fusion Applications while creating the spreadsheet. The template contains an instruction
sheet to help guide you through the process of entering the required information.

You can import Inbound Fiscal Documents from other systems using the Import Inbound Fiscal Document Attributes
process. Use the Import Inbound Fiscal Document Attributes process to import fiscal document attributes that are
related to Payables Transactions, therefore inbound fiscal documents.

To access the template, complete these steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. Inthe Table of Contents, click File-Based Data Imports.
3. Click Inbound Fiscal Document Import.
4. Inthe File Links section, click the link to the Excel template.
Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.

- Do not change the order of the columns in the template.

- You can hide or skip the columns you do not use, but do not delete them.
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Settings That Affect the Inbound Fiscal Document Attributes Import Process

The Import Inbound Fiscal Document Attributes template contains an instructions tab, plus one tab that represent the
table where the data is loaded:
Spreadsheet Tab Description

Instructions and CSV Generation Contains instruction information about preparing and loading data, the format of the template,
submitting the Import Outbound Fiscal Document Attributes process, and correcting import errors.

Fiscal Attribute Headers Captures Fiscal Document Header data from which Fiscal Documents headers are created after
successful import. Fiscal Document header is created and tied to a Receivables or Payables

(JG_FSCL_HDRS_ATRB_INT) Transaction.

Fiscal Attribute Header Details Captures the Fiscal Document Header Details data that you intend to assign to imported transactions.

Data in this sheet is linked to the parent entity sheet Fiscal Attribute Headers using Document Id.
(JG_FSCL_HDR_DTLS_ATRB_INT)

How Inbound Fiscal Document Attributes Import Data Is Processed
Loading the Data

After you finish preparing the data, you must load the data. To load the data:

1. Onthe Instructions and CSV Generation tab of the template, click the Generate CSV File button to generate a
Zip file containing one or more CSV files.

2. From Scheduled Process, use Load Interface File for Import and select Import Inbound Fiscal Document
Attributes as the import process.

3. In Data File, select Upload a new file and then select the Zip file you created.

Importing the Loaded Data

After you successfully load your data, you must submit the Autolnvoice processes to import the data into the
application tables and create the transactions.

- Use the Import Payables Invoices process to create the Payables transactions

« Use the process Import Inbound Fiscal Document Attributes to create the Inbound Fiscal Document Attributes
related to the Payables transactions

For more information on the Payables Invoice Import Interface process, refer to Oracle Enterprise Repository for Fusion
Applications.

To submit the Import Inbound Fiscal Document Attributes process:

1. Navigate to Payables > Invoices work area.
2. Click the Import Inbound Fiscal Document Attributes link in the Tasks section.
3. Enter the input parameters as needed:

Input Parameter Description

Batch Name The batch name used in the Load File for Import Process

48
ORACLE



Oracle Fusion Cloud Financials Chapter 2

Using Financials for the Americas Financials for Brazil
Input Parameter Description
From Transaction Number / To The range of transactions to be processed

Transaction Number

From Date / To Date The range of documents in between those dates to be processed

4. Submit the process.

5. Monitor the process in the Scheduled Process page.

6. If the Import Inbound Fiscal Document Attributes process ends in error or warning, review the log file for details
about the rows that caused the failure.

To correct import errors:

-—

Navigate to Payables > Invoices work area.

In the Task section, click Correct Import Inbound Fiscal Document Attributes Errors. This will download a
spreadsheet with the name CorrectinterfaceTransaction.xlIsx.

Open the spreadsheet CorrectinterfaceTransaction.xIsx.

Enter the login details.

Review and correct the import errors in the spreadsheet.

After all incorrect rows are corrected, resubmit the process by clicking the Save and Submit Import Inbound
Fiscal Document Attributes button.

7. Repeat the submit and error correction steps in this section until all rows are imported successfully and the
transactions are created.

N

A ol

Bulk Processing of Fiscal Documents Based on Shipping
Transactions

You can generate shipping transaction-based fiscal documents for Brazil in bulk. This removes an existing restriction to
process shipping transactions individually for fiscal document generation.

When the Shipment transaction is eligible for fiscal document processing, the import process can perform these tasks in
a single process request:

- Initiate the fiscal document request.

- Upload the related fiscal attributes.

- (Optional) Generate the fiscal document.
- Create the fiscal document XML extract.

You can use the existing FBDI for fiscal documents based on Receivables transactions on Shipping transactions with the
same required fiscal attributes, with these minor differences:

- Transaction Batch Source Name is used only for fiscal documents based on Receivables transactions.
- Transaction Number represents the Receivables Transaction Number or the Shipment Transaction Delivery ID.

- Legal Reporting Unit Name doesn't need to be populated for a Shipping transaction as the import process
derives it from the legal reporting unit associated with the source inventory organization.
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- A new column for Source Document Number is provided in the FBDI and used only for Shipping transactions
where it represents:

o the Sales Order Number for a Shipping transaction originating from a sales order.
o the Transfer Order Number for a Shipping transaction originating from a transfer order.

o the Purchase Order Number for a Shipping transaction originating from a return to vendor.

- Line Number represents the Receivables Transaction Line Number or the Shipment Source Line Number.

The Source Document Number and corresponding lines can be verified on Manage Shipments page.

This image shows the Outbound fiscal document import FBDI template example with shipping transactions.

Document Actions

* Required

W ) ) W ) W ) W ) ) W ) T“Fiscal Document Transaction Batch W
*Batch Name Business Unit Name *Transaction Number *Fiscal Doc Key Fiscal Document Action *Action Reason Source Source Name
BULK0202 Vision Brazil 2444623 Cancellation request Customer dropped out  Inventory Management
BULK0202 5230665100200000161013090000006591475093680  Voiding request Incorrect ion date Inventory
BULK0202 Vision Brazil INV37911 Cancellation request Customer dropped out Receivables AR_Trans Source_01C_Dir
BULK0202 "35230665100200000161013090000006591475093680  C: ion request C ion using FD key  Receivables
BULK0202 Vision Brazil INV380193 Cancellation request Customer dropped ot Receivables AR_Trans Source_01C_Dir
BULK0202 Vision Brazil INV380194 Cancellation request Customer dropped out  Receivables AR_Trans Source_01C_Dir

Bulk Processing of Void and Cancel Actions for Fiscal Documents

You can void and cancel fiscal documents for Brazil in bulk. This action makes corrections easier in integration scenarios
where fiscal documents originate from external systems.

You can use the Import Document actions File-Based Data Import (FBDI) to process multiple voiding or cancellation
requests.

To request a cancellation of a fiscal document associated with a Receivables transaction, provide either the Fiscal
Document Key or the Receivables Transaction Batch Source Name and the Transaction Number combination.

To request a cancellation or voiding of a fiscal document associated with a Shipping transaction, provide either the
Fiscal Document Key or the Shipment Number.

Here's an example of the Import Document Actions FBDI template:

Document Actions

* Required

W ) ) W ) W ) W ) ) W ) T“Fiscal Document Transaction Batch W
*Batch Name Business Unit Name *Transaction Number *Fiscal Doc Key Fiscal Document Action *Action Reason Source Source Name
BULK0202 Vision Brazil 2444623 Cancellation request Customer dropped out  Inventory Management
BULK0202 5230665100200000161013090000006591475093680  Voiding request Incorrect ion date Inventory
BULK0202 Vision Brazil INV37911 Cancellation request Customer dropped out Receivables AR_Trans Source_01C_Dir
BULK0202 "35230665100200000161013090000006591475093680  C: ion request C ion using FD key  Receivables
BULK0202 Vision Brazil INV380193 Cancellation request Customer dropped ot Receivables AR_Trans Source_01C_Dir
BULK0202 Vision Brazil INV380194 Cancellation request Customer dropped out  Receivables AR_Trans Source_01C_Dir

For more information about the Import Document Action FBDI, see the Import Document Actions section in the File-
Based Data Import (FBDI) for Financials guide.
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Transaction Taxes

Value Addition During Tax Calculation

Certain taxes in Brazil like ICMS-ST require you to estimate the final price of the product for evaluating the tax amount
on a transaction.

You can estimate the final price by applying a value addition percentage, as notified by the tax authority, on the
transaction amount. Oracle Tax lets you configure calculation of value addition percentage and tax through the taxable
basis formula.

In the taxable basis formula, if the country associated with the tax regime is Brazil, then an option is enabled for
specifying value addition information. Different value addition percentages can be configured based on these
transaction parameters:

- Ship-from geography

- Ship-to geography
Product fiscal classification

- Transaction business category
Intended use

You can specify the order of evaluation for these transaction parameters.

You can also use base rate modifier as a generic value addition option. However, the taxable basis formula provides
better control and flexibility as you can specify the required values through a single taxable basis formula based on
various transaction parameters.

Price Thresholds During Tax Calculation

Certain taxes in Brazil require applying of notified thresholds on prices of items quoted on a transaction. You can
configure taxable basis formula in Oracle Tax to configure handling of price thresholds for tax calculation.

In the taxable basis formula, if the country associated with the tax regime is Brazil, then an option is enabled for
specifying the price threshold information. Use these transaction parameters to configure the taxes:

- Ship-from geography

- Ship-to geography
Product fiscal classification

- Transaction business category
Intended use

You can specify the order of evaluation for these transaction parameters.

You can also define price threshold values through:

Fixed price: If the fixed price option is set, then the specified price is used as item price for deriving the taxable
basis amount for the transaction line.
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« Minimum or maximum threshold options: If minimum or maximum thresholds option is used, then the item
price is compared against the given range of values and appropriate value is considered if it goes beyond the
given range.

For example, if the item price on a transaction is quoted as 28 USD and the minimum threshold value is set as 32 USD,
then the minimum threshold value gets applied (that is, 32 USD, instead of 28 USD) for calculating the taxable basis
amount. However, if the item price is quoted as 48 USD and the maximum threshold value is set as 45 USD, then the
item price is set at the maximum specified value (that is, 45 USD, instead of 48 USD).

You can define price thresholds with minimum and maximum values at the tax or jurisdiction level using the threshold
basis as Line and type as Unit price. However, during the evaluation process, values notified in the taxable basis formula
will always take first precedence. Also, handling of minimum threshold value derived from the threshold controls of tax
or jurisdiction is different from the approach used when it is derived from taxable basis formula. In this case, if the item
price is less than the specified minimum threshold value, then it is considered as 0.00 USD while calculating the taxable
basis amount.

Charges During Tax Calculation

Certain taxes in Brazil require inclusion of charges while calculating taxable basis value of a transaction line. Oracle Tax
lets you handle charges for tax calculation through taxable basis formula.

If the taxable basis type within a taxable basis formula is specified as Line amount, then you can add freight, insurance,
packing charges, miscellaneous, and subtract commercial discount on the transaction line value.

If a transaction line is categorized into any of these charge types: freight, insurance, miscellaneous, packing charges,
or commercial discount, and if the taxable basis formula of a tax is configured to consider these values during tax
calculation, then the corresponding allocated values from these lines (to the item lines) are added or subtracted while
calculating the taxable basis value of that tax.

This table lists the line amount for two products along with some charges.

Line Description Amount Allocation

1 ltem A 2800

2 ltem B 1000

3 Freight 100 Freight for item A is 60 and item B
is 40

4 Commercial Discount -20 item Ais -20

If IPI tax is applicable on item A and taxable basis formula associated with it has the options to add allocated freight and
subtract commercial discount, then the taxable basis amount for transaction line 1is 2,840 USD.

This table gives the breakup of the taxable amount.
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Component Amount
Transaction line value 2800
(add) Allocated freight 60
(subtract) Commercial discount 20
Taxable Basis 2840

Differential Taxes for Brazil

In Brazil, differential tax is applicable when goods are procured from a different state at a lower tax rate when they can
be sourced from within the state.

Along with the regular tax, difference between intra-state and inter-state tax rate is additionally levied as differential tax
on the customer procuring the goods. This tax becomes payable in the state where the goods are received.

For example, consider an organization located in location A that procures an item from a supplier located in location B.
ICMS tax is applicable on the transaction. The tax rate is 18% if it is sourced from within the state (intra-state rate) and is
12% if sourced from outside the state (inter-state rate).

This table provides details of the ICMS tax that is applicable for this transaction.

Tax Details Example

Transaction amount 1000 USD

Tax Rate (inter-state) 12%

Tax amount 1000 *12% =120 USD

This table provides details of the differential tax that is applicable to the transaction:

Tax Details Example
Transaction amount 1000 USD
Differential Rate 18% (-) 12% = 6%
Tax amount 1000 * 6% = 60 USD
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The total tax payable is 180 (120+60) USD.
Consider these points when configuring ICMS differential tax in Oracle Tax:

- Generally ICMS (differential) tax is not notified in the fiscal document sent by supplier. It must be assessed and
paid by the organization procuring the goods or services from a different state. Therefore, configure it as self-
assessed tax.

- To apply this tax as self-assessed, tax registration party must be configured to derive Ship-to Party or Bill-to
Party. Further, tax registration record associated with the legal reporting unit must be marked as self-assessed.

- Tax rate percentage of this tax is a derived value and is the difference between intra-state and inter-state ICMS
tax rates. This result is achieved through configuration of tax calculation formula:

o ICMS tax would use inter-state tax rate percentage for calculating the tax amount.ICMS (differential) tax
must be configured to derive the corresponding intra-state tax rate.

o Tax calculation formula associated with ICMS (differential) must have compounding rule for subtracting
the ICMS tax from its tax amount.

o On processing the tax calculation formula, ICMS (differential) will result in a tax amount equal to the
difference between intra-state and inter-state tax rates.

- ICMS (differential) is to be calculated along with ICMS tax. So, the tax applicability conditions for both these
taxes must match.In addition to it, ICMS (differential) must have rule conditions to allow its applicability only on
purchase transactions and on specific states, if applicable.

- ICMS (differential) involves compounding on ICMS tax. So the compounding precedence specified on the
respective tax regimes or taxes must support this, therefore, the precedence number for ICMS must be less
than ICMS (differential).

- ICMS (differential) tax is not applicable if the intra-state tax rate is less than the inter-state tax rate. This
condition is inherently managed by the tax calculation logic, tax is not applied on the transaction if the
differential amount between the compounded taxes results in a negative value.

Tax Substitutions

Tax substitution concept is widely followed in countries such as Brazil. It refers to transferring the responsibility for
paying taxes that become applicable at various stages within the supply chain, to one of the parties involved therein.

In summary, one party within the supply chain (generally the producer) pays the entire tax that becomes applicable till
the material reaches the user.

An organization located in location A sells an item to a customer located in the same state. Based on the requirement,
ICMS tax is applicable at 18% and the onus of tax substitution is on the original supplier, with a specified value addition
of 40% (based on item, nature of transaction and other criteria).

This table provides the required tax treatment in the context of this example.

ICMS-ST Example

Transaction Line amount 10,000 USD

Value Addition Percentage 40%

Net transaction line amount 10,000 *1.40 = 14,000 USD
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ICMS-ST Example
Base ICMS-ST Tax amount (@ 18%) 14,000 * 18% = 2,520 USD
Less: ICMS Tax (@ 18%) 10,000 *18% = 1,800 USD
ICMS-ST amount 2,520 -1,800 =720 USD

This table provides the Tax configuration for ICMS-ST.

Tax Configuration Description

Tax ICMS-ST is applied in addition to the regular tax. So, it must be configured as a separate tax. This is to
be calculated on the net value addition that accrues within the supply chain, over the base transaction.
So, it is to be configured similar to a differential tax.

Taxable Basis Formula Taxable basis formula should include value addition configuration. Value addition conditions should
match with the applicability criteria of the tax.

Tax Calculation Formula Tax calculation formula must be defined for compounding on ICMS tax, with the compounding rule set
to Subtract.

This table provides the tax calculation processing for ICMS-ST based on this setup:

Tax Details Example

Taxable Basis Amount (after applying 10,000 * 1.40 = 14,000 USD
value addition)

Calculated Tax Amount (before 14,000 * 18% = 2,520 USD
compounding)

Less: ICMS Tax (based on compounding 1,800 USD
rule)

Calculated Tax Amount (after 2,520 (-) 1,800 =720 USD
compounding)
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Consider these points while configuring ICMS-ST taxes:

ICMS-ST has three different variants such as:
o ICMS-ST Forward: This amount is notified on the fiscal document, along with ICMS tax.

o ICMS-ST Anticipated: This amount is not notified on the fiscal document. Receiver of the goods or
services is responsible for assessing the tax and paying it to the tax authority.

o ICMS-ST Backward: This tax is applicable for road transportation services availed through a third
party transportation company. Party contracting for the transportation services (buyer or supplier) is
responsible for assessing the tax and paying it to the tax authority.

In situations involving the Forward approach, tax should be configured for application on both purchase and
sales events. In case of situations involving the Anticipated or Backward approach, tax conditions should cover
only purchase events and it should get applied as Self-assessed tax.

To apply this tax as self-assessed, the tax registration party must be configured to derive Ship-to Party or Bill-
to Party. Further, tax registration record associated with the Legal Reporting Unit should be marked as Self-
assessed.

Taxable basis amount for ICMS-ST is based on either estimated sale price (if notified by the tax authority) or
a value addition percentage. If transactions exist with a combination of these criteria, then different taxable
basis formulas should be defined with Price Thresholds and Value addition details. Rule conditions could be
configured to pick the appropriate taxable basis formula.

If taxable basis formula is based on price thresholds, then it should be configured with Fixed Price option.
Also, the precedence levels should be appropriately marked for processing price thresholds or value addition,
especially when the evaluating criterion is similar. As done in case of rule order evaluation, most commonly
used transaction criteria should be set with least precedence numbers.

ICMS-ST is calculated along with ICMS Tax. So, the tax applicability conditions for both these taxes must match.
In addition, ICMS-ST should include criteria relating to Forward or Anticipated or Backward approach for
processing specific treatment on this tax based on transaction details.

ICMS-ST represents differential tax amount between what is legitimately payable by the party in the regular
course of business and what could be the total tax that becomes payable by all the transacting parties within
the supply chain. This value can be achieved through the configuration of tax calculation formula, with
compounding rule for subtracting ICMS tax.

As ICMS-ST involves compounding on ICMS tax, the compounding precedence specified on the respective tax
regimes or taxes must support it, the precedence number for ICMS must be less than ICMS-ST.

Rapid Implementation to Configure Brazilian Taxes

You can use the rapid implementation spreadsheets to configure the basic tax setup, that is, regime to rate and tax rules
for Brazil. However, in certain areas, some additional configuration is required.

These table provides details of the additional steps that need to be performed for some tasks.

Task

Additional Steps Notes

Tax Regime Create compounding precedence On certain transactions, IPl is compounded

on ICMS. ICMS is also compounded on ICMS-
ST or ICMS (Differential). So, appropriate
compounding precedence must be set for each
tax regime.
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Task

Taxes

Tax Rates

Taxable Basis Formula

Tax Calculation Formula

Tax Registrations

Tax Rules

Receivables

Additional Steps

Set the default applicability, default taxable
basis formula and the default tax calculation
formula

Revise the rate type

Create compounding and additional data setup

Create compounding

Mark self-assessment

Update list of values

Chapter 2
Financials for Brazil

Notes

Taxes are created with the default applicability.
They must be set as not applicable, if rules are
configured for applicability. Similarly, standard
taxable basis formula and tax calculation
formula are used as default values for few taxes
(like IPI, ICMS-ST) must be changed.

If IPI tax is to be applied based on quantity
instead of percentage, then the rate

type attribute configured through rapid
implementation requires manual correction.

Taxable basis formula for ICMS tax requires
compounding of IPl tax. Some taxes like
ICMS-ST also require configuration of price
thresholds or value additions.

Tax calculation formula for taxes like
ICMS (differential) and ICMS-ST require
compounding on ICMS tax.

ICMS (Differential) and ICMS-ST may be
required to be calculated as self-assessed. Tax
registration records will need correction.

Few tax rules are based on list of values. All
such values must be manually configured.

Sales Invoice and Customer Receipt Enhancements for Brazil

To support the common business practices in Brazil, the payment collection process is enhanced to support
transactions between suppliers, customers, and their banks. You can now automatically generate and electronically
transmit collection documents to banks for collecting payments due from customers.

The processes are automated using electronic file transfers that transfer information from companies to banks and the

return from banks to companies.

You can:

- Process receipt files from banks for the associated collection documents. Include taxes and short payments on
collection documents submitted for Receivables invoices.

- Use city-specific calendars to identify local holidays and ensure due dates are accurately assigned, and late
payment interest is correctly calculated and included in the collection documents for bank transfers.
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- Send remittance collection documents to customer banks based on invoice payment terms.

- Send remittance update collection documents for any updates, discounts, or protests to process corrections to
files that are already sent.

- Receive bank files with information on payments collected from customers, and create and apply receipts.

- Use the Receivables REST API to update installment due dates and generate automatic bank occurrences of the
transactions associated with the collection documents sent to the bank.

Note: You can't update installments of the transactions associated with a consolidated collection document
with multiple installments.

Create Receivables Invoices and Generate Remittance Batch
These enhancements are available for generating a remittance batch:

- Create Receivables transactions and complete them by receiving final approval on the associated fiscal
documents. Receivable invoices associated with approved fiscal documents are then available to be included in
a remittance batch for collection.

- Use a remittance batch to send information to the customer's bank for payment collection. The information
sent to a bank includes instructions such as interest charges to be collected and any protest after due date.
When generating a remittance batch, selection criteria can be specified to automatically or manually select the
installments to include in the batch. Collection documents are created in Receivables for the installments. After
creating collection documents to be sent to the bank, review the collection documents selected in the batch and
remove any, if needed.

- Enter parameters during batch creation to limit selection of records or default information, such as the
maximum quantity of documents per remittance batch, minimum or maximum amount for a document, or a
minimum or maximum total amount for the remittance batch.

- Assign specific bank remittance formats to each bank. Once the remittance batch details have been reviewed,
the remittance batch is generated base upon the assigned format and validated. The batch can be edited
to correct errors and re-generated. A remittance batch can also be canceled before a bank return is done if
needed.

Updates to Collection Documents

Use bank collection updates to provide additional directions to a bank for collection documents that are already sent
in a remittance batch. Once the updates are entered, create a collection update remittance batch to send to a bank.
Collection document updates can be created automatically based on certain actions or can be created manually as
needed to process collection document updates.

Bank Returns and Receipts

Receive information from banks as a file that can be imported. Use the Import Bank Returns for Brazil program to
import and validate the bank return details in the file and to upload and validate records that have been manually
entered in a spreadsheet. A validation is performed against the associated collection documents and bank return
records rejected by this process are shown in the Bank Return Import Report.

Rejected bank return records can be corrected and a Correct Bank Returns spreadsheet used to upload corrected
information. The uploaded details are also validated by the same import process. After completion of import process,
AR receipts are created automatically and can be applied using the standard Receivables processes.
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Document Numbering for Sales Transactions

You can now automate document numbers generation for invoices and related transactions for the sales made by
your organization. These document numbers are based on the document class, third party of the transaction, and
transaction type.

The resultant values are the branch number and the sequence, the combination of these values makes up the
document number to be stamped on the transaction.

To automate document numbering for your organizations, complete the setup:

- Set Localization settings: Use the Manage Localization System Options task to update the country in which
your business unit operates. Select the Country field. Check the Enable Document Numbering check box.

- Define document numbering: Use the Manage Localization Document Numbering task and set the country.
Select the business unit for which you want to define document numbering.

- Specify the party fiscal classifications: Select the Configure Context Values option on the Manage Localization
Document Numbering page, an ADFDi spreadsheet appears. Specify the party fiscal classifications that will
specify the document letter in document numbering sequence.

- Select the document class, document letter, and the transaction type for which you want to specify a document
number. Select the document sequence and authorization codes that need to be applied during a given period.

Document numbers are stamped on the transaction to indicate completion of an action.

Import Outbound Fiscal Documents

Use the Import Fiscal Document Attributes Template to populate your Fiscal Document Attributes and upload them into
Oracle Fusion Cloud Applications. Prepare the required Fiscal Document Attributes offline in the applicable spreadsheet
templates.

The template contains an instruction sheet to help guide you through the process of entering the required information.

You can import Fiscal Documents from other systems using the Import Autolnvoice with Fiscal Attributes process.
Use the Import Autolnvoice with Fiscal Attributes process to import fiscal document Attributes that are related to
Receivables transactions, therefore, outbound fiscal documents..

To access the template, complete these steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. Inthe Table of Contents, click File-Based Data Imports.
3. Click Outbound Fiscal Document Import.
4. In the File Links section, click the link to the Excel template.
Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.

- Do not change the order of the columns in the template.

-+ You can hide or skip the columns you do not use, but do not delete them.
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Settings That Affect the Outbound Fiscal Document Attributes Import Process

The Import Fiscal Document Attributes template contains an instructions tab, plus four tabs that represent the table
where the data is loaded:

Spreadsheet Tab Description

Instructions and CSV Generation Contains instruction information about preparing and loading data, the format of the template,
submitting the Import Outbound Fiscal Document Attributes process, and correcting import errors.

Fiscal Attribute Headers Captures Fiscal Document Header data from which Fiscal Documents headers are created after
successful import. Fiscal Document header is created and tied to a Receivables Transaction.
(JG_FSCL_HDRS_ATRB_INT)

Fiscal Attribute Header Details Captures the Fiscal Document Header Details data that you intend to assign to imported transactions.
Data in this sheet is linked to the parent entity sheet Fiscal Attribute Headers using Document Id.
(JG_FSCL_HDR_DTLS_ATRB_INT)

Fiscal Attribute Lines Captures Fiscal Document Lines information for imported transactions. Data in this sheet is linked to
the parent entity sheet, Fiscal Attribute Headers, using Document Id.
(JG_FSCL_LINES_ATRB_INT)

Fiscal Attribute Line Details Captures the Fiscal Document Line Details data that you intend to assign to imported transactions.
Data in this sheet is linked to the parent entity sheet, Fiscal Attribute Lines, using Document Id and
(JG_FSCL_LN_DTLS_ATRB_INT) Transaction Line Number.

How Outbound Fiscal Document Attributes Import Data Is Processed
Loading the Data

After you finish preparing the data, you must load the data. To load the data:

1. On the Instructions and CSV Generation tab of the template, click the Generate CSV File button to generate a
Zip file containing one or more CSV files.

2. From Scheduled Process, use Load Interface File for Import and select Import Process Import Autolnvoice
with Fiscal Attributes as the import process.

3. In Data File, select Upload a new file and then select the Zip file you created.

Importing the Loaded Data
After you successfully load your data, you must submit the Autolnvoice processes to import the data into the
application tables and create the transactions.

- Use the Import Autolnvoice process to create the Receivables transactions

- Use the Import Autolnvoice with Fiscal Attributes process to create the Outbound Fiscal Document Attributes
related to the Receivables transactions

For more information on the Receivables Autolnvoice Import process, refer to Oracle Enterprise Repository for Fusion
Applications.
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To submit the Import Autolnvoice with Fiscal Attributes process:

Navigate to the Scheduled Processes page.

Click Schedule New Process in the Search Results table.

Select the Import Autolnvoice with Fiscal Attributes process and click OK.
Enter the input parameters as needed:

PUNA

Input Parameter Description
Batch Name The batch name used in the Load File for Import Process
From Transaction Number / To The range of transactions to be processed

Transaction Number

From Date / To Date The range of documents in between those dates to be processed

5. Submit the process.

Monitor the process in the Scheduled Process page.

If the Import Autolnvoice with Fiscal Attributes process ends in error or warning, review the log file for details
about the rows that caused the failure.

NOo

To correct import errors:

Navigate to the Billing work area.

From the Fiscal Document Generation menu, go to Spreadsheet for Fiscal Attribute Corrections.

Review the Autolnvoice with Fiscal Attribute Errors table to view the errors.

Click the Number of Errors link to open the Manage Autolnvoice with Fiscal Attributes Lines spreadsheet to

review and correct the errors in the imported data.

5. After all the incorrect rows are corrected, resubmit the import data for validation by clicking Submit Autolnvoice
with Fiscal Attributes.

6. Repeat the submit and error correction steps in this section until all rows are imported successfully and the

transactions are created.

POUN

Upload Receivables Bank Returns Data

On receiving collection instructions, the bank collects the amounts and returns information in an electronic format.
Those details are imported into the application through this process.

This process validates each record against the related collection documents, supplier, customer, and the related setup.
For records that are invalid, the details appear in an ADFdi spreadsheet 'Correct Bank Returns' and it allows to make
the required corrections and import the corrected records. After all the records in a bank return file are successfully
validated, the Bank Return process can be initiated to generate return collection document updates and receipts, and if
applicable, adjustments for interest and discounts. In cases where the calculated interest is different from the received
interest, debit memos can be automatically generated or the differences be written off (depending on defined tolerance
limits). Receipts are applied to the original installments that were selected in a collection document.

To access the template, complete these steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
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2. Inthe Table of Contents, click File-Based Data Imports.

3. Click Receivables Bank Returns Data Upload Interface.

4. In the File Links section, click the link to the Excel template.
Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.

- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

Settings That Affect the Receivables Bank Returns Data Upload Interface

The template consists of two sheets:

- Instructions and CSV Generation

- Receivables Bank Returns

You can enter data in the Receivables Bank Returns sheet per the guidelines in this table:

Field Name Comments

FILE_CONTROL Bank Control File number received from Bank

ENTRY SEQUENTIAL NUMBER Register sequence number on electronic file received from the bank.

REGISTER_TYPE Identifier for header, detail and trailer records in electronic file received from the bank.
TRADE_NOTE_AMOUNT Amount due remaining on collection document received from the bank.

FILE_GENERATION_NUMBER Oracle internal use only.

COMPANY_CODE Company code provided by the bank at the time of contract for services associated with the remittance

and return of a collection document.

COMPANY_NAME Company name of the first party associated with the company code provided by the bank.
GENERATION_DATE Date on which the interface records were generated. Date Format: MM/DD/YYYY
REMITTANCE_CODE Bank remittance code in electronic file from the original line sent by the company.
BANK_NUMBER Unique numeric identifier for a bank.

BANK_OCCURRENCE_CODE Occurrence code returned by the bank related to a bank occurrence.

OCCURRENCE_DATE Correction date for a bank occurrence received from the bank. Date Format: MM/DD/YYYY
INSCRIPTION_NUMBER Company registration number in electronic file received from the bank.
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Field Name

COMPANY_USE

OUR_NUMBER

PORTFOLIO_CODE

YOUR_NUMBER

DUE_DATE

COLLECTOR_BANK_NUMBER

COLLECTOR_BRANCH_NUMBER

TRADE_NOTE_TYPE

BANK_CHARGE_AMOUNT

ABATEMENT_AMOUNT

DISCOUNT_AMOUNT

CREDIT_AMOUNT

INTEREST_AMOUNT_RECEIVED

CUSTOMER_NAME

RETURN_INFO

BANK_USE

Chapter 2
Financials for Brazil

Comments

Collection document unique identifier for matching purposes.

Collection document identifier generated by the bank or the company responsible for the collection
document printing.

Portfolio code in electronic file received from the bank.

Collection document number related to the document given by the company.

Due date for a collection document received from the bank. Date Format: MM/DD/YYYY

Numeric identifier for collecting bank.

Numeric identifier for collecting bank branch.

Oracle internal use only.

No longer used.

Abatement amount for a bank collection document received from the bank.

Discount amount for a bank collection document received from the bank.

Credit amount for a collection document received from the bank.

Paid interest amount for a collection document received from the bank.

Customer name on a collection document received from the bank.

Return information comment on a bank occurrence on a collection document received from the bank.

Operation identifier by bank on electronic file received from the bank.

How Receivables Bank Returns Data Upload Interface Is Processed

The Brazil Bank Return Files Import and Validation flow starts with users receiving Customer Payments Banks
Processing Return files with the respective formats. You have to implement a custom process to execute a conversion to
the Oracle Financials Cloud Import format and generate a .csv file based on that format. This file must be transmitted to
Oracle Cloud UCM. The Load and Import process and the Validate process are executed.
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Load the Data into the Interface Tables

1. After you finish preparing the data in the parent and child sheets, click the Generate CSV File button. The
process generates both a CSV file and a ZIP file.
2. Load the data using the Load Interface File for Import process:

S 0 20 OO

Sign in to the Oracle Public Cloud SFTP server.

Transfer the ZIP file to the SFTP server location.

Sign in to Oracle Fusion Cloud Applications.

Navigate to Scheduled Processes.

Select Load Interface File for Import.

Select the process indicated in the Overview section to load the CSV file to the interface tables.
Review the results of the process.

If necessary, correct any errors in the CSV file and rerun the Load Interface File for Import process.

3. Correct load errors:

a.

b.

If the load of the CSV file fails on any row, the Load Interface File for Import process ends in error and the
Load File to Interface child process ends in either warning or error.

All rows that were loaded from the CSV file are deleted including the ones that loaded successfully.

This lets you edit the problematic data in the spreadsheet and resubmit without having to separate the
successful rows from the rows that need modification.

Review the log and output files of the Load File to Interface child process for information about the data
that caused the failure.

Correct the data in the template you used.

Repeat steps 1and 2 of this section: Generate the CSV file and load the data using the Load Interface File
for Import process.

Repeat all of these steps until all data is loaded successfully.

Set Up Receivables Collection Documents for Brazilian Central
Bank Instant Payment System

You can use the Brazilian Pix instant payment system to set up Receivables collection documents for Brazil.

When enabled, Receivables collection documents for Brazil make use of the Brazilian banking model that supports the
instant payment system enhancement in conjunction with standard collection document processing.

The bank processes the remittance file that is enabled for Pix using both the current collection document system
and the instant payment system. The bank then returns an occurrence file with the standard collection document
confirmation and the instant payment system QR code.

1. Add the instant payment system identification to your company bank account.
2. Enable instant payment system processing in the global receipt method used to process collections.
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3. Inthe Manage Bank Accounts page select one of the available Pix Key Types:
o Taxpayer ID
o Email Address
o Mobile Phone Number
o Random Key

4. Enter the Pix Key after a Pix Key Type is selected.
5. Enable Pix Processing on the Global Receipt Method page to indicate to the bank the collection documents included
in a remittance batch will use the hybrid model and will also be processed in the instant payment system.

Receivables collection document processing, including remittance batch creation and occurrence return, remains
unchanged. The differences are in the Receivables bank file layout and the Import Bank Returns for Customer
Payments FBDI, with additional columns related to instant payments.

For more information about the Receivables collection documents for Brazil, see Sales Invoice and Customer Receipt
Enhancements for Brazil

For more information about the Import Bank Returns for Customer Payments FBDI, see Receivables Bank Returns
Data Upload Interface

Payables

How You Pay Enhancements for Brazil

Use Oracle Fusion Cloud Financials to manage your Payables transactions and comply with the local Brazilian business
practices and government regulations.

You can manage the collection documents received from the supplier and associate it with an invoice or payment
schedule in order to pay invoices or installments. If any invoices are paid late, interest is calculated and added to the
invoice amount according to the agreed terms between the seller and buyer and in compliance with the locally legislated
business calendar.

You can:
- Enter a collection document manually or import an electronic collection document and associate it with one or
more invoices or installments.

- Place holds on invoices or installments that are not associated with any collection document and automatically
release holds after assignment.

- Calculate and pay interest for late payments based on predefined rules from suppliers. The interest is calculated
based on rules that govern penalties, grace periods, and interest calculation methods. Use local business
calendars to determine the number of days for interest calculation.

- Process payments by banks using electronic files. Use the Manual Bank Return and Import Bank Return
processes to identify and process rejected payments, corrections, and maintain invoice associations.

Use these features to record a manual collection document or import an electronic collection document, and associate it
with one or more installments:

- Create a Payables invoice.
- Associate collection documents with invoices.
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- Calculate interest and pay through Payment Process Request.

» Manual Bank Return and Import Bank Return

Create Payables Invoice

Create a Payables invoice based on the information received from supplier. When creating an invoice, update the
global descriptive flexfields. To update the global descriptive flexfields, click the Additional Information tab. You will
have to select the Invoices for Brazil option for the Regional Information field. Select Yes for the Enable Collection
Document Processing field.

After an invoice is created, an installment is generated for the invoice with due dates and payment amounts. It also
includes the information updated in the global descriptive flexfields for the collection document.

When an invoice is validated, the installment is placed on hold until it is associated with a collection document.

For interest calculation, update the relevant information for payment schedules. To update the relevant information,
click the Manage Installments from Invoice Actions list and then click the Details button. Select Payment
Installment Information for Brazil from the Regional Information list. Provide the interest calculation details and save
it.

Associate Collection Documents with Invoices or Installments

Once the collection document is entered into the application either manually or imported, the next step is to associate it
with the installments. The collection document includes information such as barcode number, supplier name, supplier
site, gross amount, due date, the details of bank where payment is to be made, document details, discount details, and
so on. This association can be automatic or manual.

There are predefined setups and tolerance limits for automatic association, based on these setups and tolerances
automatic association is done by the application. If the application cannot perform automatic association, then manual
association is to be done by the user at a later stage. You can dissociate an installment from a collection document, if
you think the current installment can't go with the current collection document.

Once the association of the installment is complete, the hold applied on the invoice is removed automatically.

Calculate Interest and Make Payments

When invoices are paid after the due date, interest and penalties are charged on the invoices according to the agreed
terms between the buyer and the seller. The interest can be simple interest or compound interest and penalty can be
amount or percentage. You can define some grace days based on the type of interest that is charged.

Define a business day calendar and local holidays for the city based on which the due date is determined. Interest is
calculated on the overdue invoices based on the due date.

Based on settings, interest can be calculated for late payments on invoices taking into consideration the number of
grace days that are defined and whether the payment due date falls on a non-business day.

For the interest calculated, a new interest invoice is automatically created and the same is included in the next batch for
payment.

To ensure the correct interest is collected, a local business day calendar with the correct local holidays for the city of
the supplier must be defined. Interest is calculated on the overdue invoices based on the due date and taking into
consideration the number of grace days that are defined and whether the payment due date falls on a non-business
day.

66
ORACLE



Oracle Fusion Cloud Financials Chapter 2
Using Financials for the Americas Financials for Brazil

Process Bank Returns

The bank sends an electronic fund transfer file that gives the status of the payments made against invoices for the
submitted collection documents. The electronic fund transfer file provides information on whether the payment was
successful or rejected.

When a payment is rejected, the reasons for rejection are recorded against each invoice. Codes and reasons for rejection
are maintained in the application.

Once the EFT file is imported into the application, the application associates the rejected invoice with the relevant
reason for return. This enables further action like making a payment for the same in future.

Upload Payables Bank Returns Data

Bank return import file contains details sent by the bank on the status of payment requests that have been sent to the
bank for payment.

Bank return import file contains the details of each payment using the reference of the Return Identifier, which uniquely
identifies a specific payment request made to the bank. Different banks use different bank return codes. On importing
the details, the status of the collection documents that are matched with the invoice installments get updated based on
the corresponding return codes.

To access the template, complete these steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. Inthe Table of Contents, click File-Based Data Imports.

3. Click Payables Bank Returns Data Upload Interface.

4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.

- Do not change the order of the columns in the template.
- You can hide or skip the columns you do not use, but do not delete them.

Settings That Affect the Payables Bank Returns Data Upload Interface

The template consists of two sheets:

- Instructions and CSV Generation

- Bank Returns

You can use this table to populate the Bank Returns sheet:

Name Comments

BANK_RETURN_ID Value generated during the processing of a payment request. It is passed to bank in a payment request
file. It is also used to uniquely refer individual payment requests.

BANK_OCCURRENCE_CODE Occurrence error details sent by the bank. It is also a foreign key to the JL_BR_AR_BANK_
OCCURRENCES table.
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Name Comments
OCCURRENCE_DATE Occurrence error date sent by the bank.
PAYMENT_REQUEST_IDENTIFIER ESS ID of the payment request.

How Payables Bank Returns Data Upload Is Processed

Brazil Bank Return Files Import and Validation flow starts with Users receiving Payer Banks Processing Return files with
respective formats. Users have to implement a process to execute a conversion to Oracle Financials Cloud Import format
and generate a .csv file based on that format. That file must be transmitted to Oracle Cloud UCM. Load and Import
process and Validate process must be executed.

Load the Data into the Interface Tables

1. After you finish preparing the data in the parent and child sheets, click the Generate CSV File button. The
process generates both a CSV file and a ZIP file.

2. Load the data using the Load Interface File for Import process:

Sign in to the Oracle Public Cloud SFTP server.

Transfer the ZIP file to the SFTP server location.

Sign in to Oracle Fusion Cloud Applications.

Navigate to Scheduled Processes.

Select Load Interface File for Import.

Select the process indicated in the Overview section to load the CSV file to the interface tables.
Review the results of the process.

If necessary, correct any errors in the CSV file and rerun the Load Interface File for Import process.
3. Correctload errors:
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a. If theload of the CSV file fails on any row, the Load Interface File for Import process ends in error and the
Load File to Interface child process ends in either warning or error.

b. All rows that were loaded from the CSV file are deleted including the ones that loaded successfully.
This lets you edit the problematic data in the spreadsheet and resubmit without having to separate the
successful rows from the rows that need modification.

c. Review the log and output files of the Load File to Interface child process for information about the data
that caused the failure.

d. Correct the data in the template you used.

e. Repeat steps 1and 2 of this section: Generate the CSV file and load the data using the Load Interface File
for Import process.

f. Repeat all of these steps until all data is loaded successfully.

Upload Payables Collection Documents Data

The process starts once the supplier sends a collection document against which payment has to be made.
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This process is used to import collection documents from the bank, as initiated by the supplier. If the import validation
errors option is set to NO, then the collection lines are auto-matched with the transaction installments. If it's set as YES,
then based on the action set, either the primary or the reference data is changed, or the import lines are rejected and
the bank is informed.

To access the template, complete these steps:

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide.
2. Inthe Table of Contents, click File-Based Data Imports.

3. Click Payables Collection Documents Data Upload Interface.

4. In the File Links section, click the link to the Excel template.

Follow these guidelines when preparing your data in the worksheet:

- Enter the required information for each column. Refer to the tool tips on each column header for detailed
instructions.

- Don't change the order of the columns in the template.
- You can hide or skip the columns you don't not use, but don't delete them.

Settings That Affect Payables Collection Documents Data Upload Interface

The template consists of two sheets:

- Instructions and CSV Generation
- Payables Collection Documents

You can enter data in the Payables Collection Documents sheet per the guidelines in this table:

Field Name Comments

FILE_CONTROL Bank control file name received from the bank.
ENTRY_SEQUENTIAL_NUMBER Entry sequential number on an imported bank collection document.
DOCUMENT_NUMBER Collection Document number on an imported bank collection document.
DOCUMENT_DATE Date on an imported bank collection document.

CNAB_CODE No longer used.

DUE_DATE Due date on an imported bank collection document.

AMOUNT Total amount of associated installments on an imported bank collection document.
ARREARS_DATE Use the same date as in DOCUMENT _DATE.

ARREARS_CODE Use 1.

ARREARS_INTEREST Use 1.
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Field Name

DRAWEE _NAME

DRAWEE_BANK_CODE

DRAWEE_BANK_NAME

DRAWEE_BRANCH_CODE

DRAWEE_ACCOUNT_NUMBER

DRAWEE_INSCRIPTION_TYPE

DRAWEE_INSCRIPTION_NUMBER

TRANSFEROR_NAME

TRANSFEROR_BANK_CODE

TRANSFEROR_BRANCH_CODE

TRANSFEROR_ACCOUNT_NUMBER

TRANSFEROR_INSCRIPTION_TYPE

TRANSFEROR_INSCRIPTION_NUMBER

ACCOUNTING_BALANCING_SEGMENT

SET_OF_BOOKS_ID

ORG_ID

BARCODE_TYPE_CODE

BARCODE

ELECTRONIC_FORMAT_FLAG

ORACLE
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Comments

Registered Payer name on an imported bank collection document.

Payer bank code on an imported bank collection document.

Payer bank name on an imported bank collection document.

Payer bank branch code on an imported bank collection document.

Payer account number on an imported bank collection document.

Payer inscription type on an imported bank collection document.

Payer Taxpayer Id on an imported bank collection document.

The Supplier name of a bank collection document.

Bank code of the supplier on an imported bank collection document.

Branch code of the supplier on an imported bank collection document.

Account number of the supplier on an imported bank collection document.

Inscription type of the supplier site on an imported bank collection document.

Taxpavyer ID of the supplier site on an imported bank collection document.

No longer used.

No longer used.

Indicates the identifier of the business unit associated to the row.

Type of barcode used for a Brazilian Payables collection document.

The numeric representation of barcode number (manual) or the barcode number (scanned).

Electronic bank collection indicator.
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How Payables Collection Documents Data Upload Interface Is Processed
Load the Data into the Interface Tables

1. After you finish preparing the data in the parent and child sheets, click the Generate CSV File button. The
process generates both a CSV file and a ZIP file.

2. Load the data using the Load Interface File for Import process:
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Sign in to the Oracle Public Cloud SFTP server.

Transfer the ZIP file to the SFTP server location.

Sign in to Oracle Fusion Cloud Applications.

Navigate to Scheduled Processes.

Select Load Interface File for Import.

Select the process indicated in the Overview section to load the CSV file to the interface tables.
Review the results of the process.

If necessary, correct any errors in the CSV file and rerun the Load Interface File for Import process.

3. Correct load errors:

a.

b.

If the load of the CSV file fails on any row, the Load Interface File for Import process ends in error and the
Load File to Interface child process ends in either warning or error.

All rows that were loaded from the CSV file are deleted including the ones that loaded successfully.
This lets you edit the problematic data in the spreadsheet and resubmit without having to separate the
successful rows from the rows that need modification.

Review the log and output files of the Load File to Interface child process for information about the data
that caused the failure.

Correct the data in the template you used.

Repeat steps 1and 2 of this section: Generate the CSV file and load the data using the Load Interface File
for Import process.

Repeat all of these steps until all data is loaded successfully.
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5 How To Topics

Configure Fiscal Documents for Brazil

Overview of Configuring Fiscal Document for Brazil

You can now create and manage fiscal documents for Brazil by using the fiscal document generation feature in Oracle
Fusion Cloud ERP. In Brazil, fiscal documents are required to comply with the regulations of the tax authorities.

Tax authorities also register a transfer of ownership of goods or commercial activity by a company to an individual or to
another company.

You can use the fiscal document generation feature to create and manage fiscal documents for:
- Sales invoices
Internal transfer shipments
- Shipments of returns to suppliers
Internal transfer of fixed assets

As the fiscal document generation process is integrated with Receivables, you can perform these tasks before invoices
are completed:

Enter the appropriate fiscal attributes
- Calculate taxes
- Generate a fiscal document for sales invoices
Since this feature is also integrated with Shipping, you can perform these actions:
- Capture the fiscal attributes
- Generate and manage the fiscal documents before the internal transfers and RTV shipments are released.

For fixed asset transfers, the required transaction information is moved to Receivables, so that a fiscal document can be
generated based on a non-receivable invoice.

Enable Brazil Localization

You must enable Brazil Localization to complete the configuration tasks that are specific to tax handling in the Fiscal
Document Capture feature.

Follow these steps:

1. Click Navigator, Others and then click Setup and Maintenance work area.

On the Setup page, select Offering, Financials and click Opt In Features.

On the Opt In page, search for Financials and then click the Features icon in the Features column.
In the Edit Features page, select Regional Localization.

In the Enable column, click Features.
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6. In the Feature Name page, select Brazil.
7. Click Save and Close.

Enable the Fiscal Document Feature

You can use the Manage Localization System Options task to enable fiscal document processing for the business units
that capture fiscal documents.

Follow these steps:

1. From the Setup and Maintenance work area, navigate to the Manage Localization System Options task.
Click Create.

In the Create Localization System Options page, select the business unit.

Select the Enable Fiscal Document Processing check box.

Click Save and Close.
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Create Brazil Geography

You must define the geography structure, the geography validation, and the address format for Brazil before generating
fiscal documents.

Follow these steps:

1. Define the geography structure necessary to generate fiscal documents. Follow these steps:
a. Navigate to the Manage Geographies task.

In the Country Name field, select Brazil.

From the Actions menu, select Manage Geography Structure.

Click Create.

Select the Geography Types as State and click Add.

Other geography types available are City and Postal Code.

Select the geography type as City and click Add.

Select the geography type as Postal Code and click Add.

Click Save and Close.
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2. Configure the geography validation and address styles for Brazil. Follow these steps:

a.

ang

e L

k.

Navigate to Manage Geographies task.
Search for the country name Brazil.
From the Actions menu, select Manage Geography Validation.
Click Add and add these address style formats:
- Brazil Postal Address Format
- Brazil Tax Address Format
In the Address Style Format field, select No Styles Format.
In Geography Mapping and Validation region, select the geography type as State.
Select the Enable List of Values, Tax Validation, and Geography Validation check boxes.
Select the geography type as City.
Select the Enable List of Values, Tax Validation, and Geography Validation check boxes.

Repeat these substeps for the Brazil Postal Address Format and Brazil Tax Address Format address style
formats.

Click Save and Close.

3. Configure the address format for Brazil. Follow these steps:

a.

b.
c.
d.

8.

Navigate to the Manage Address Format task.
Search for Brazil Postal Address Format.
Click Edit.
In the Format Layout section, add these address elements:
- Address Line 1
- City
- State
- Country
You can add additional elements if necessary.
Select these fields and the check boxes:

Address Fields
Field Name Required Check Box Uppercase Check Box
Address Line 1 Yes No
City Yes Yes
State Yes Yes
Country Yes Yes

Click Save and Close.

4. Configure the Brazil Tax address format by repeating the substeps for the previous step.

Define Localization Document Numbering

You can define a different fiscal document series according to your business needs for example, adopt a different series
for the document inbound and outbound transactions.
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Different legal reporting units can share one series. However, only one combination of legal reporting unit and series
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can use a fiscal document sequence. Different legal reporting units or different series cannot share the same sequence.

Hence, fiscal document numbering is sequential per establishment and per series, as required by the tax authority.

You can use the Manage Document Sequence Categories and Manage Document Sequences tasks to create the fiscal

document sequences. Follow these steps:

1. Create a document sequence category. Follow these steps:

a.
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Navigate to Manage Document Sequence Categories task.

Click New.

Select the application as Receivables.

Enter a category code and a category name.
Select the module as Receivables.

Enter RA_CUSTOMER_TRX_ALL as the table.
Provide a description for the sequence category.
Click Save and Close.

2. Create a document sequence. Follow these steps:

Q
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Navigate to the Manage Document Sequences task.

In the Search Results section, click New.
Enter a document sequence name.
Select the application as Receivables.
Select the module as Receivables.
Select the type as Gapless.

Enter a start date.

In the Assignment section, click New.

Select the document sequence category name created in previous substeps.

Select the method as Automatic.
Enter a start date.
Click Save and Close.

ORACLE
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3.

Create a fiscal document series and assign document sequences to legal reporting units and series. Follow these

steps:

Navigate to the Manage Localization Document Numbering task.

Search for Brazil.

Click Create.

In the Legal Entity field, select the legal entity you want to assign the fiscal document sequence to.

In the Legal Reporting Unit field, select the legal reporting unit you want to assign the fiscal document

sequence to.

f. Inthe Series field, select the series you want to associate with the legal reporting unit. Tip: You can create a
new fiscal document series by clicking the Create button.
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g. a.0nthe Create Series page, enter the series and series description.
h. b. Optionally, you can select the default fiscal document model as 1, 1A, or 55 and the printing format as
Landscape or Portrait.
i. Inthe Sequence field, select the document sequence created in the previous substeps.
j- Enter a start date.
k. Select the Enabled check box.
I. Click Save and Close.
m. For more information on document sequence categories and document sequences, see the Implementing

Common Features for Oracle Financials Cloud guide at docs.oracle.com.

For more information on document sequence categories and document sequences, see the Implementing Common
Features for Oracle Financials Cloud guide at docs.oracle.com.

Define Fiscal Attribute Templates

You can configure some of the fiscal attribute values as default values using a fiscal attribute template.

Fiscal attributes are captured on the Fiscal Attributes page during the transaction entry. They are required for fiscal
document generation. Once you select the fiscal attribute template on the Fiscal Attributes page, the template values
are defaulted to the Fiscal Attributes page.

Follow these steps:
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Navigate to Manage Fiscal Attribute Templates for Brazil task.
In the Search Results section, click Create.
In the Attribute Template field, enter the template name.

. Click Enabled.

Enter the start date of the record.
In the Header Information section, in the Industry Type field, select the type of industry, if applicable.

Note: Fuel, medicine, sugarcane, vehicle, and weapon are the industry types for which the tax authority requires
specific information in the fiscal documents. The industry specific attributes are captured on the Fiscal Attributes
page during the transaction entry.

In the Payment Option field, select Cash payment option, Installment payment option, or Other payment option
value. This is a required field on the Fiscal Attributes page.

In the Statement of Commitment field, enter the commitment statement identification for public sector purchasing.
In the Purchase Contract field, enter the purchase contract information for reporting to the tax authority.
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10.1n the Freight Type field, select Freight on receiver account, Freight on sender account, Freight on third party, or No
freight as applicable for the fiscal document.

11. In the Associated Legal Messages section, enter the legal message code and the legal message text that are reported
to the tax authority.

12. Click Save and Close.

Define Fiscal Document Generation Controls and Defaults

You can define the fiscal document generation controls and the defaults for each business unit, application, and event
class that generates a fiscal document.

This configuration also enables the Fiscal Document Generation task in the Billing work area. Follow these steps:

1. Navigate to Manage Fiscal Document Generation Controls for Brazil task.
2. Search for Fiscal Document Control.

3. Inthe Search Results section, click Create.

4

. On the Create Fiscal Document Generation Controls page, for Event Class field, select the event class for which you
want to define the controls and the defaults. This table lists the event class and the corresponding fiscal document

type:

Event Class and Fiscal Document Types

Application Event Class Fiscal Document Type

Inventory Management Returns to supplier shipment Return to supplier fiscal documents
Inventory Management Transfer order shipment Internal material transfer fiscal documents
Receivables Debit memo Complementary fiscal documents based on

debit memo transactions

Receivables Invoice Regular fiscal documents based on invoice
transactions

5. In the Associated Business Units section, for the Business Unit field, select the business unit for which you want to
define the controls and defaults for the fiscal document generation. Only the business units that were enabled for
fiscal document processing are available for selection.

6. You can optionally isolate the controls and defaults by transaction-based fiscal classifications. In the Document Fiscal
Classification field, select the fiscal classification that identifies the transaction.

7. Enter the start date of the record.
. Click Enabled.

9. To complete the invoice before the fiscal document is approved by the tax authority, select the Allow Completion
Before Fiscal Document Generation check box in the Control Information section.

(o]

Note: You can complete the invoice manually regardless of the fiscal document’s status. However, if this check box
is not selected, the invoice cannot be completed before the corresponding fiscal document is approved. Once the
tax authority approves it, the invoice is automatically completed.

10.In the Product Type field, select the product type and configure the default values for goods, services, or mixed fiscal
documents.
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11. In the Fiscal Attributes Defaults section, for the Goods Series field, select the series default value. During transaction
entry, this value defaults on the Fiscal Attributes page for goods and mixed fiscal documents.

Note: Only the series defined for a business unit, application, event class, and document fiscal classification is
available for selection on the Fiscal Attributes page.

12. In the Services Series field, select the series default value. This value defaults on the Fiscal Attributes page for service
and mixed fiscal documents.

Note: Only the series defined for a business unit, application, event class, and document fiscal classification is
available for selection on the Fiscal Attributes page.

13. In the Attribute Template field, select the fiscal attribute template. During transaction entry, the default values
defined for the template are automatically populated on the Fiscal Attributes page.

14.In the Contingency Type field, select the contingency type default value. This value defaults on the Enter
Contingency Information page, when a contingency fiscal document is requested by clicking Generate Contingency
Fiscal Document on the Manage Fiscal Document Generation page.

15.In the Contingency Series field, select the contingency series default value. This value defaults on the Enter
Contingency Information page, when a contingency fiscal document is requested by clicking Generate Contingency
Fiscal Document on the Manage Fiscal Document Generation page.

16.In the Contingency Reason field, enter the contingency reason default value. This value defaults on the Enter
Contingency Information page, when a contingency fiscal document is requested by clicking Generate Contingency
Fiscal Document on the Manage Fiscal Document Generation page.

17. Click Save and Close.

Note: Tip: You can use document fiscal classifications to assign different fiscal document series as default values
for different types of transactions.

18.If you use a different series for inbound and outbound goods fiscal documents, create one document fiscal
classification for inbound transactions and another for outbound transactions. Follow these steps:

a. On the Fiscal Document Generation Controls page, create a record for the first document fiscal
classification and assign the inbound goods series as the default value.

b. Create another record for the second document fiscal classification and assign the outbound goods series
as the default value.

c. During transaction entry, on the Create Transaction page, click the Miscellaneous tab.

d. Enter the specific document fiscal classification. This makes the corresponding goods series default to the
Fiscal Attributes page.

For more information on transaction-based fiscal classifications, see the Oracle Financials Cloud Implementing Tax
guide at docs.oracle.com.

Define Tax Authority Time Controls

You can define time controls for each tax authority. Before defining the time controls, you must define a tax authority
party tax profile using the Manage Legal Authorities task.

The Manage Fiscal Document Generation page uses the time controls configuration. When you click the Void Fiscal
Document or Cancel Fiscal Document button, the corresponding action is allowed only if it is within the configured
period of time.

Follow these steps:
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1. Configure the time controls for the tax authority. Follow these steps:

a.
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Navigate to Manage Document Sequence Categories task.
Click New.

Select the application as Receivables.

Enter a category code and a category name.

Select the module as Receivables.

Enter RA_CUSTOMER_TRX_ALL as the table.

Provide a description for the sequence category.

Click Save and Close.

2. Define the SEFAZ tax authority for the legal reporting unit. Follow these steps:

a.
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Navigate to the Manage Party Tax Profiles task.

Search for Tax Authority Tax Profiles.

Enter the name of the tax authority.

Click Search.

Select the tax authority tax profile record.

Click Edit. The Edit Tax Authority Tax Profile page opens.

Select the country as Brazil. This displays the Document Time Controls section.
Click Add Row.

In the Document Control Type field, select the action to be controlled according to time limits, like void or
cancel fiscal document.

In the Time Limit field, enter the time limit.

In the Units field, select Hours, Days, Months, or Next month as the time unit.
Enter a start date.

Select Enabled.

Click Save and Close.

Note: Define a time limit control based on the day of the month by using Next Month as a unit. For
example, to allow voiding a fiscal document only until the 10th day of the next month:

Select Void as the document control type.
Enter 10 as the time limit.
Select Next Month as the unit.

Each legal reporting unit that generates fiscal documents must have a corresponding tax authority
associated with the legal reporting unit tax registration. For the legal reporting unit, the state inscription
number (IE) and municipal inscription number (IM) must be defined earlier.
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3. Define the city tax authority for the legal reporting unit. Follow these steps:

a. Navigate to the Manage Tax Registrations task.

b. Search for Legal Reporting Unit Tax Profiles.

c. Inthe Search section, search for the legal reporting unit.
d.
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How To Topics

On the Tax Registrations tab, select the record corresponding to municipal inscription number of this legal

reporting unit.
e. Click Edit.

f. On the Edit Legal Reporting Unit Tax Registration page, for the Reporting Tax Authority field, select the
reporting tax authority. This should be the same legal authority defined previously to represent the city tax

authority.
g. Click Save and Close.

For more information on the state inscription number (IE), municipal inscription number (IM), and configuring tax
registrations in Brazil, see the Quick Reference for Oracle ERP Cloud Documentation for Brazil (2329725.1) on My

Oracle Support at https://support.oracle.com.

For more information on document sequence categories and document sequences, see the Implementing Common

Features for Oracle Financials Cloud guide at docs.oracle.com.

Define Lookup Codes

Configure IBG Geography Codes

You can create IBG geography codes by specifying a lookup value for geography identifier subtype.

The tax authority requires geography identification codes. The Brazilian Institute of Geography and Statistics (IBGE)

defines standard numeric codes for each city and state in Brazil.

Note: In the geography structure, they are defined as alternative codes.

Follow these steps:

Navigate to the Manage Geography Lookups task.
Select HZ_GEO_IDENTIFIER_SUBTYPE.
In the Lookup Codes section, click New.
Enter the lookup code as IBGE_CODE.
Enter the start date of the record.
Click Enabled.
Enter these values:
a. Inthe Meaning field, enter the Brazil IBGE Geography Code.
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b. Inthe Description field, enter the Brazil IBGE Geography Code.

c. Inthe Tag field, enter C.
8. In the Attribute field, enter a value.
9. In the Meaning field, enter the Brazil IBGE Geography Code.
10.1n the Description field, enter the Brazil IBGE Geography Code.
11. In the Tag field, enter C.
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12. Click Save and Close.

Configure the Fuel Product Code

You can configure fuel product codes.

For the fuel industry, the tax authority requires the fuel product code. The National Agency of Petroleum provides the
standard codes. The fuel product code of the fiscal document is captured on the Update Fiscal Attributes page during
transaction entry. The corresponding values are set up as lookup codes of the predefined Fiscal Document Fuel Product
Code lookup type.

Follow these steps:

Navigate to the Manage Standard Lookups task.

Search for the Fiscal Document Fuel Product Code lookup type.

In the Lookup Codes section, click New.

In the Lookup Code field, enter the numeric fuel product code defined by the National Agency of Petroleum.
Click Enabled.

Enter the start date.

In the Meaning field, enter the fuel product code meaning.

In the Description field, enter the fuel product code description.

Click Save and Close.
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Define IBGE Codes for Cities and States

You can configure the corresponding IBGE code as an alternative code for the geography for each state,

Each city and state has a standard numeric code defined by the IBGE. The tax authority requires this code as the
standard geography identification. During the fiscal document generation process, the IBGE codes associated with the
location addresses related to the fiscal document are extracted and communicated to the tax authority

Follow these steps:

1. Configure the corresponding IBGE code as an alternative code for the geography for each state. Follow these steps:
a. Navigate to the Manage Geographies task.
Search for Brazil country.
Select the Brazil geography record and click Hierarchy Defined.
In the Geography Hierarchy section, select the first state under Brazil to highlight the table row.
Click Edit. The Edit State page opens.
In Primary and Alternative Codes section, click Add.
Enter these values:
i. Inthe Code field, enter the IBGE numeric code of the state
i. Inthe Code Type field, enter the Brazil IBGE City Code
iii. Inthe Data Provider field, enter the User entered data provider.
iv. Inthe Language field, enter Brazilian Portuguese.
h. Click Save and Close.
i. Repeat these substeps for the other states.
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2. Configure the corresponding IBGE code as an alternative code for the geography for each city. Follow these steps:
a. Navigate to the Manage Geographies task.
Search for Brazil country.
Select the Brazil geography record and click Hierarchy Defined.
In the Geography Hierarchy section, select the first state under Brazil to highlight the table row.
Click the View list, and select Expand.
Select the first city under the state to highlight the table row.
Click Edit. The Edit City page opens.
In the Primary and Alternative Codes section, click Add.
Enter these values:
i. Inthe Code field, enter the IBGE numeric code of the state

ii. Inthe Code Type field, enter the Brazil IBGE City Code

iii. Inthe Data Provider field, enter the User entered data provider.

iv. Inthe Language field, enter Brazilian Portuguese.
j- Click Save and Close.
k. Repeat these substeps for the other cities.

For more information on document sequence categories and document sequences, see the Implementing Common
Features for Oracle Financials Cloud guide at docs.oracle.com.
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Configure Transaction Taxes

You can view the calculated transaction tax lines on the Fiscal Document page before you extract the tax information in
the fiscal document extract file.

In Brazil, taxes such as IPI, ICMS, PIS, COFINS, and ISS are configured as transaction taxes in Oracle ERP Cloud. Since
transaction taxes must be reported on the fiscal document that is sent to the tax authority for approval, they are
calculated on Receivables invoices and Shipment transactions prior to the generation of the fiscal document.

You can configure these fiscal classifications as tax reporting types:

IPI Legal framework codes
PIS CST codes
« COFINS CST codes
ICMS CST codes
IPI CST codes
ICMS taxable basis determination codes
ICMS-ST taxable basis determination codes
ICMS exemption condition codes
ISS applicability codes

Configure the tax reporting types and tax reporting codes and associate them with the tax configuration to represent
different tax situations. Tax reporting types and tax reporting codes are extracted into the fiscal document extract file
along with the other fiscal document information.
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Understand the Fiscal Document Cancellation Flow

You can cancel a fiscal document for various reasons, such as errors in the fiscal document data, cancellations by a
customer, or issues in the shipment process.

Make sure that the fiscal document fulfils these requirements to cancel a goods or services fiscal document:
- Fiscal document is approved by the tax authority.

- Corresponding taxable event has not taken place yet. For example, goods were not issued or services were not
provided.

- Cancellation is requested within the prescribed time limit specified by the tax authority.

- Any other tax authority requirement.

These steps outline the flow of a service fiscal document with tax differences:

1. Create a service invoice in Receivables with the tax determinants and transaction information required for the fiscal
document. Transaction taxes and withholding taxes are calculated according to the tax configuration.

2. Inthe Actions menu, select Request for Fiscal Document. The transaction becomes read-only and the fiscal
document status changes to Transaction Entered.

3. Inthe Actions menu, select Update Fiscal Attributes.

4. After you enter the additional transaction information required for the fiscal document, click Submit. The fiscal
document status changes to Scheduled.

5. Run the Generate Fiscal Document process to verify if the information required for the fiscal document generation is
available. If the validation passes, a fiscal document key and a fiscal document sequential number are provided. The
fiscal document status changes to Generated.

6. The fiscal document is now available for extraction and consumption by a third party, who submits the request for
the tax authority approval. The Send Fiscal Document to Tax Authority process creates an extract file containing the
fiscal document information and changes the fiscal document status to Sent.

7. Partners generate the fiscal document XML file based on the extract file and communicate with the city tax authority.

8. The city tax authority can approve or raise validation errors for the fiscal documents. Partners communicate the tax
authority response through the Import Fiscal Document Approval Information process.

9. If the tax authority raised errors in the fiscal document, the status changes to Errors. You must correct the setup or
transaction information and request for the fiscal document again.

10.If the fiscal document is approved, the Import Fiscal Document Approval Information process verifies if the taxes
indicated by the city tax authority are different from the taxes calculated previously in the service invoice. If the taxes
are the same, the fiscal document status changes to Approved and the invoice is automatically completed.

11. If the city taxes are different from the calculated taxes, the fiscal document status changes to Approved with tax
error and the invoice is automatically completed. Click Fiscal Document Status and review the Tax Name, Taxable
Amount, Tax Rate, and Tax Amount as indicated by the tax authority. Based on this information, create a tax invoice
adjustment to record the tax differences.

For more information on the standard fiscal document approval flow and fiscal documents based on Receivables
transactions, see the Quick Reference for Oracle ERP Cloud Documentation for Brazil (2329725.1) on My Oracle
Support at https://support.oracle.com.
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Define Item Catalog and Categories

You can configure the fiscal classifications as item catalogs and associate the item categories to each item.

You can associate these item categories:

NCM: Mercosal common classification

EX-TIPI: IPI tax list exception codes
- Origin of goods: Item origin classification for ICMS tax
- CEST: Tributary substitution specifier code

- CNAE:National Classification Of Economic Activities
Note: Allitem catalogs and item categories associated with items of the fiscal document are extracted into
the fiscal document extract file to be sent to the tax authority. From the Fiscal Document extract file, the
partner gets the fiscal classification code and item catalog name.

You can define NCM and EX-TIPI as product fiscal classifications. During transaction entry, after an inventory item is
indicated in the transaction line, the product fiscal classification defaults from the item category associated to the item.

Create an Item Catalog and Item Categories for NCM And EX- TIPI

Follow these steps:

From the Product Information Management work area, navigate to the Manage Catalogs task.

On the Manage Catalogs page, click Create.

On the Create Catalog page, for the Catalog Name field, enter the name of the catalog for NCM and EX-TIPI.

In the Catalog Code field, enter the catalog code.

In the Description field, enter the catalog description.

In the Controlled At field, select the Master Level or Organization Level values.

Enter the start date.

Click Save and Continue.

On the Edit Catalog page, click Edit in Spreadsheet. This launches the Categorylmport spreadsheet.

10. Connect to the application.

11. On the Catalog Category workbook, click Insert Rows For Create.

12. Addthe NCM codes as item categories under this item catalog. Enter the necessary categories for your
business, including the EX-TIPI codes as part of the NCM codes.

13. Click Upload.

VWONCUAWNA

Create and Associate a Product Fiscal Classification Type Group With an Item Catalog
Follow these steps:

From the Setup and Maintenance work area, navigate to the Manage Product-Based Fiscal Classifications task.
On the Manage Product-Based Fiscal Classifications page, search for Product Fiscal Classification Type.

Click Create.

On the Inventory Category Set field, select the item catalog created previously.

On the Product Fiscal Classification Type region, for the Fiscal Classification Type Group field, enter the name of
the fiscal classification type group.

In the Type Code field, enter the code of the NCM structure.

VAWNS
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7. Inthe Type Name field, enter the name of the NCM structure.
8. Inthe Start Position field, enter 1.
9. Inthe Number of Characters field, enter the number of characters of the NCM structure.
10. Enter the start date.
11. Click Save and Close.

Note: You can optionally create multiple levels for the product fiscal classification type group, according to
the structure of NCM and EX-TIPI. This may be necessary if you want to define tax rules based on specific
segments of the NCM structure.

Define the Default Product Fiscal Classification for a Transaction Line
Follow these steps:

1. From the Setup and Maintenance work area, navigate to the Manage Country Default Controls task.

2. Search for Brazil.

3. Click Edit.

4. Inthe Primary Inventory Category Set field, select the item catalog created in previous steps. This is the default
product fiscal classification for a transaction line.

5. Click Save and Close.

Associate Each Inventory Iltem With the Corresponding Item Category
Follow these steps:

From the Product Information Management work area, navigate to the Manage Items task.

Search for the item.

Click on the item to edit.

In the Categories tab, click Add Row.

In the Catalog field, select the item catalog created in previous steps.

In the Category field, select the corresponding NCM and EX-TIPI fiscal classification code. This item category
defaults to the transaction line product fiscal classification.

CUPUWNDL

Configure Service Fiscal Classifications

If you have configured the services provided by your company as inventory items, you can define the corresponding
service fiscal classifications as product fiscal classifications

Follow these steps:

1.

Create an item catalog with each item category as a service fiscal classification.

2. Create a product fiscal classification type group and associate this item catalog.
3.
4. Associate each service item with the corresponding item category.

Define this item catalog as the default product fiscal classification.
Note: During transaction entry, if the transaction line has an inventory item, the service fiscal classification is
captured as the product fiscal classification and the value defaults from item catalog.

If the services are not configured as inventory items, you can enable the service fiscal classification to be captured as
product category.
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a. Define each service fiscal classification code as a product category fiscal classification code.

b. Select the service fiscal classification code as a product category in the transaction line during a transaction

entry.

Note: If the city service fiscal classification code is different from the national fiscal classification code for

the same service, use different levels of the product classification structure.

c. Define the national fiscal classification codes in the upper levels of the item catalog hierarchy or product

category fiscal classification hierarchy, depending on how you configure the services.
The local service fiscal classifications are the child nodes of the national fiscal classification nodes. The

national fiscal classification codes are defined as the first level and city service fiscal classification codes as

the second level of item categories.

For more information on product fiscal classifications and product categories, see the Oracle Financials Cloud
Implementing Tax guide at http://docs.oracle.com.

Define Ship-From and Ship-To Legal Reporting Units

For shipment transactions, you must define the legal reporting unit associated with the ship-from and ship-to
organizations required by fiscal document generation.

Follow these steps:

Navigate to the Manage Associated Business Entities task.

Click Selected Scope.

Select the ship-to legal entity and legal reporting unit used for internal material transfer shipments.
. Click Add Row.

Select the type as Ship-from or to location.

Select the name of the location associated with the legal reporting unit. During fiscal document generation for
internal transfer shipments, the configuration is used associate the legal reporting unit to the ship-to location.

For more information on legal reporting units and business entities association, see the Implementing Common
Features for Oracle Financials Cloud guide at http://docs.oracle.com.
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Define CFOP

The operations fiscal code (CFOP) is a fiscal classification for transactions defined by the government of Brazil. It is

a mandatory attribute for goods and mixed fiscal documents. During transaction entry, the CFOPs are captured as a
transaction business category. Transaction business categories are tax determinants in the transaction line level.The
operations fiscal code (CFOP) is a fiscal classification for transactions defined by the government of Brazil. It is a
mandatory attribute for goods and mixed fiscal documents. During transaction entry, the CFOPs are captured as a
transaction business category. Transaction business categories are tax determinants in the transaction line level.

To configure transaction business categories, follow these steps:

1. Navigate to the Manage Transaction-Based Fiscal Classifications task.

2. Search for Transaction Business Category Codes.

3. Inthe Search section, enter the fiscal classification code as one of the predefined levels.
4. Click Search.
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Select the record from the search results.

Click Create Child Node to add additional levels.

On the Create Fiscal Classification page, enter the code as CFOP numeric code.
Enter the name as the CFOP description.

. Select the country as Brazil.

10.Enter the start date of the record.

11. Click Save and Close.
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Define Vehicle Use for Vehicle Industry

You can define vehicle use as an intended use tax determinant and select the appropriate vehicle use during transaction
entry.

Vehicle Use is a specific attribute for the vehicle industry, and required for fiscal documents related to the sale of
vehicles.

Follow these steps:

Navigate to the Manage Product-Based Fiscal Classifications task.
Search for Intended Use Fiscal Classification Codes.
Click Create.

Enter these values:
a. Inthe Code field, enter the numeric code for vehicle use.
b. Inthe Name field, enter the vehicle use name.
c. Inthe Country field, enter Brazil.

5. Enter the start date of the record.

6. Click Save and Close.
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Manage Bank Collections Remittance for Brazil

Overview

In Brazil, Banks play an important role in the company’s collections process. The payment collection process involves a
series of transactions between the supplier, customer, and the bank.

Such processes are automated using electronic file transfers that transfer information from companies to banks, and the
return from banks to companies. The data flows are as follows:

Electronic file transfer from Company to Bank

Companies send information about required collections that are based on invoice payment terms to their
collection bank (bank collections remittance).

Companies send information about updates, discounts, or protests and corrections in relation to files sent for
collection (bank collection updates remittance).

Electronic file transfer from Bank to Company
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After the collection, the bank collects a payment from the customer and transfers information to the company,
so receipts can be created and applied against the customer’s balance. This process is called Bank Collection
Returns.

Note: The electronic files mentioned previously must follow the standardized text file format defined by the
Brazilian Bank Association (FEBRABAN). The format is called Bank Automation National Center (CNAB) but
the file layout might vary slightly from bank to bank.

Solution Overview

This section discusses the solution overview of the Bank Collections Remittance process.

You can perform these tasks:
- Generate the Bank Collections Remittance file based on the customer invoices payment terms.
Define and submit corrections, and updates for the remittance files already submitted.
Import the Bank Collection Return file from the bank.
- Generate receipts and update customer’s balances.
These features are associated with the Bank Collection Remittance process:
- Create Receivables Invoices and Remittance Batch
Update Collection Documents
- Automatically Create Receipts and Bank Return

Process Flow
This image shows the steps included in the process flow.

Oracle Financials Cloud

Setup Bank Transactions Create Bank Import Automatic
Transfer entered and Collection Bank Return Receipt
completed Remittance File Generation
Generate Transmit Convert Bank
Custom BIP BIP File to Return File
Bank File(s) Bank TXT into CSV

Implementers, Partners (optional)

89
ORACLE



Oracle Fusion Cloud Financials Chapter 3
Using Financials for the Americas How To Topics

Business Flow
This image shows the steps included in the business flow.

_ ——6) Bank Processing Retu
——3) Collection Documents (CNAB) —

Company's & 2a) Bank Collections
Updates Remittance F
——4) Payment File (CNAB) —| Bank

5) Bank Processing «—2) Bank Collections

— ) Remittance File
Return File (CNAB)

€4— 1) Invoice, Trade Notes (NFF)
Customer Co

<4——1a) Collection Documents (optional)

Bank Collection Remittance Process

After you create a Receivables transaction and completes the final approval process of the fiscal document, the
Receivables invoice is available for selection in a remittance batch.

Remittance batches are used to send information to the company’s bank for payment collection. The information that is
sent to a bank can include instructions for the bank such as the collection of interest charges and protest after due date.
You can set the criteria to automatically or manually select the installments and include them in the remittance batch.

The collection documents are created in Receivables for the installments. After you create the collection documents to
send to a bank, you can review the collection documents that were selected in the batch and remove any as necessary.

You can define the limit parameters and default information for document selection such as the maximum number

of documents per remittance batch, the minimum and maximum amount for each document, and the minimum and
maximum total amount for the remittance batch. The specific bank remittance formats can be assigned to each bank.
Once the remittance batch details are reviewed, the remittance batch is formatted to send to a bank. If there is an error
in the format process, you can make corrections and reformat the batch. A remittance batch can also be cancelled
before a bank return is done.

Update Collection Documents
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The bank collection updates are used to provide further directions for the collection documents that have already been
sent to the bank.

Once the updates are created, a collection updates remittance batch is generated and formatted to send to the bank.
You can also set the automatic collection document updates based on certain actions, and also create the collection
document updates manually.

Automatically Create Receipts and Bank Return

It is important for the banks to return information about collections in the form of a file that can be imported in the
application.

The Import Bank Returns for Brazil program is available to import and validate the bank return details in the file. The
same program is used to upload and validate the records that are manually entered in the spreadsheet. Validation is
done against the related collection documents. The bank return records that are rejected by this process are shown on
the Bank Return Import Report.

Imported bank return records that were rejected during the validation process need to be corrected. A Correct Bank
Returns spreadsheet is available in Oracle Financials Cloud to upload the corrected details. The uploaded details
are validated the same as in the import process procedure. A Receivables receipt is created automatically after you
complete the import process.

Bank Transfer Configuration
You can use Oracle Financials Cloud to configure the Receivables Bank Transfer functionality.
Before completing the configuration steps, you must complete the required login configuration.

1. Sign in using your user name and password.

2. Navigate to the Setup and Maintenance work area.
3. Select Financials from the drop down list.

4. Click the Tasks icon.

Follow these configuration steps:

Manage work schedule.

Associate work schedule to Brazil calendar profile.
Manage local holidays for Brazil.

Manage remit to addresses.

Manage Localization system options.

Manage Receivables activity.

Manage receipt classes and methods.

Manage global receipt methods for Brazil.

. Manage bank accounts.

10.Manage bank update codes for Brazil.

11. Manage bank instruction codes for Brazil.

12. Manage collections remittance batch templates for Brazil.
13. Manage customer profile.

14.Manage customer profile classes.
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15. Manage customers.
16.Manage customer accounts.
17. Manage customer account sites.

Manage Work Schedule

Work schedules are required to indicate the working days and nonworking days that a company operates, considering
weekends, national, and municipal holidays.

Follow these steps to configure a work schedule:

1. Search for Manage Work Schedule.
2. Enter these values:

Field Values

Name Enter the work schedule name.
Category Work

Type Time

3. Define the working day patterns. For example, Standard 5 Day Working Week.
4. Define the working day exceptions. For example, for federal holidays, set the Start Date and End Date.

Associate Work Schedule to Brazil Calendar Profile
You must associate the work schedule to Brazil Calendar Profile:

Follow these steps:

Search for Manage Administrator Profile Values.

Search JLBR_CALENDAR in the Profile Option Code field.

Select JLBR_CALENDAR from the search results.

Navigate to the Profile Values region.

Select Site in the Profile Level field.

Select the work schedule name previously defined in the Profile Value field.
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Manage Local Holidays for Brazil
You must define the local holidays at the city level after you associate the work schedule to Brazil Calendar Profile.

Follow these steps:

1. Search for Manage Local Holidays for Brazil.

2. Search for the required Brazilian city and state. This information is retrieved from previously defined geography
elements for Brazil.

3. Enter and enable the dates corresponding to the municipal holidays for the selected city.

Note: You can also enter the state level holidays for each city belonging to a given state.
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